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About this manual

Introduction

This manual provides an introduction to the basic functionality available in 
WYSIWYG and is designed to get you started using the program. 

Text conventions

The following text conventions are used in this manual:

 Menus and menu commands appear in Arial bold. For example, “from 
the Library menu, choose Browse Library.”

 User interface elements such as buttons, tools, shortcuts, and dialog 
boxes appear in Tahoma Oblique. For example, “to draw a riser, click 
the Riser tool on the Draw toolbar.”

 Keyboard keys are indicated in ALL CAPS. For example, “press the 
TAB key to enter the missing coordinate.”

 References to manuals appear in italic font. For example, “for 
additional information on rendering, refer to the Reference Guide.”
Quick Start Guide vii
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Lesson 1 - Understanding the user interface

Introduction

In this lesson you will learn about the basic parts of the WYSIWYG user 
interface. 

Step 1 - Starting to work in WYSIWYG

When you start WYSIWYG, the Welcome window appears. The application 
level is shown in the upper right corner of the window.

To start working in WYSIWYG

1 From the WYSIWYG Welcome window, choose one of the following 4 
options:

 New File starts a blank new project file.
 Open File will display a browse window to select an existing .wyg file, or 

click on one of the recently used files shown under Open File.
 Import File allows you to import a file created from another application, 

which is saved in .dwg/.dfx or .skp file format.
 Templates lists all .wyt Template files which contain your file setting 

preferences. Select one of these files as your starting point for your 
project.
Quick Start Guide 1
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2 For the purposes of this tutorial, under New click File. 
Result: The WYSIWYG main window is displayed. 

Shortcut bar

Layout tab Status bar

Library Browser

Mode buttons

Toolbars

Menus
2
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Step 2 - Mode buttons

The Mode buttons located along the top of the user interface are used to 
access the different working modes available within the WYSIWYG levels. 
The currently selected mode is shown in orange, while modes not selected 
are shown as black. Clicking the appropriate mode button will change the 
view to that mode.

Note: Specific Layout tabs in any mode can be selected from the mode’s 
drop-down menu, enabling rapid change of views easily.

Based on the WYSIWYG product that you have purchased, the modes 
available are some or all of the following: 

 CAD - CAD mode is where you create your show drawings or “model.” 
This includes drawing your venue, set pieces, lighting positions, focus 
positions, and lighting fixtures. This is also where you can import CAD 
files.

 Data - This is where all of your fixture information is compiled into 
spreadsheets. In this mode, you can view and edit the data for all your 
fixtures.

 Design - This mode provides lighting designers with the tools for 
experimentation. In Design mode, you can create and save static 
lighting Looks using the Designer tools, and then save and render those 
looks, all without having to patch fixtures or connect to a console. 
Additionally, you can integrate automation/motion control with your 
show.
Note: (Design mode is only available in WYSIWYG Design and 
Perform).

 Pres - Presentation (Pres) mode contains all the tools necessary for 
creating professional printouts of your show documents/paperwork (i.e. 
reports and lighting plots).

 Live - Live mode is used for graphically simulating the output of a 
lighting control console or compatible offline editor. This is where you 
can pre-cue and pre-visualize your show. (Live mode is only available in 
WYSIWYG Perform).

Step 3 - Menu bar, toolbars

Below the Mode buttons is the Menu Bar. The available menus change as 
needed when moving from mode to mode. 
Quick Start Guide 3
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Toolbars provide button access to most commands and can be used in lieu 
of the menu bar. Toolbars have a grab bar on the left that is used to move 
the toolbar around the screen. They can be placed on the edges of the work 
area (top, bottom, left or right), and can also be dragged off the edge of 
the work area and into their own window.

To open/close a toolbar, right-click in the toolbar area to display a menu of 
all the available toolbars. Enable the checkbox next to a particular toolbar 
to display it. 

Step 4 - Layout tabs

Located at the bottom of the screen are Layout tabs. Each mode has 
designated layouts configured to the functionality and tools offered in each 
mode. Think of each layout as a workspace in your file for a different part 
of your project. 

Step 5 - The Library Browser

The WYSIWYG Library is an essential component of WYSIWYG. The Library 
contains an extensive catalog of lighting fixtures and accessories, truss, 
gobos and gels, 3D objects, etc. 

You can browse the contents of the library in the Library Browser. In the 
Library Browser. you can review each item's properties. When you find 
something you wish to use in your project, you can insert it from the 
library, or you can create a shortcut of the object, which will place it in the 
Shortcut bar for easier access

Step 6 - Shortcut bar

The Shortcut bar is located on the left side of your screen. You can create 
shortcuts for library items, ease of navigation, and special tools. 

Example: You can save a navigation shortcut to CAD mode/Quad layout so 
that the next time you want to go back to that location, you can simply 
click the shortcut. The navigation shortcut will also remember which tools 
you have open.
4
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To create a shortcut to CAD mode/Quad layout

1 In CAD mode, click the Quad tab to open the quad layout.

2 From the Library menu, choose Browse Library. 
Result: The Library Browser now appears along the right side of your 
workspace.

3 Select the Navigation Shortcut bar.
4 In the Navigation Shortcut bar, right-click.
Quick Start Guide 5
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5 Select New Navigation from the menu. 

Result: The Enter new shortcut name window will appear.

6 In the Enter new shortcut name window, type a name for the shortcut and 
click OK.
6
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7 The Navigation Shortcut Properties window will appear.

8 Click OK.
9 Close the Library Browser by clicking on the X button in the top right 

corner of the Library Browser.
10 Switch to a different mode / layout tab by clicking on any of the Mode 

buttons along the top of WYSIWYG.
11 Now, in the shortcut bar, under the Navigation section, click on the 

shortcut you just created. 
Result: This will bring you back to CAD mode / Quad layout. Since the 
shortcut was created with the Library Browser window open, it will be 
automatically displayed for you.

Step 7- Status Bar

The Status bar is displayed along the bottom of the WYSIWYG screen, 
below the Layout tabs. The Status bar displays useful information while 
working on your project, such as the prompt line, the selected object 
information, the missing coordinate, and the status of the snap, ortho and 
absolute coordinates commands. The Status Bar also tracks and displays 
the coordinates of the cursor.

The prompt line displays the current status of a command within your 
drawing. If you are currently working with a command that requires 
multiple steps (the placement of a pipe, for example), the prompt line 
displays a message indicating the next step required to accomplish that 
task. The prompt line also displays a short description of a command when 
you point to it using your mouse.
Quick Start Guide 7
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For more information on the Status bar, please refer to the Reference 
Guide.

Selected object Unused channels
Absolute Missing Units of 

measurement
Snap and 
OrthocoordinatecoordinatesPrompt line

Step 8 - Window Position Management

Most tools in WYSIWYG create a separate window where all the options of 
the tool are available. Window positions of these tools can be customized to 
suit most work styles. WYSIWYG will remember the window preference of 
the tool the next time.

Window position options can be accessed by clicking the down arrow at the 
top of the window, and opening the Window Position drop-down menu.

 Floating - The window will appear in the foreground of the WYSIWYG 
file. The window will not be attached to any border of the work space or 
any other window. If the resolution of WYSIWYG or the work space is 
8
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resized, the window will remain in its current position and in the 
foreground.

 Docking - The window will be attached to a border of the work space. If 
the resolution of WYSIWYG or the work space is resized, the window 
will change its resolution to match the new work space size.

 Tabbed Document - Tools with similar display options can share the 
same window space. The tabbed document can be either floating or 
Quick Start Guide 9
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docked. At the bottom of the window will be tabs showing the names of 
the different tools. Click on the tabs to switch between tools as needed.

 Auto Hide - This option is only available for docked windows. When 
enabled, the window will be hidden from view by default. A tab will 
appear on the side of the WYSIWYG application window with the name 
of the auto hidden window. When the tab is selected, the window will 
reappear in its previously docked location. The window will continue to 
10
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be visible until another window or feature is selected, or until you click 
off of it.

 Hide - The selected window will close. To view the window again, the 
feature must be accessed again.

To display a window as tabbed

1 Identify the tools/features that you wish to tab together. 

2 Click and drag one tool window over to another tool window, until the 
arrows appear over the tool.

3 Without releasing the mouse, move your cursor to the square in the 
middle of the arrows that appear, and then release the mouse.
Result: The tools will now be tabbed together.

To toggle the auto hide setting of a window

Click the Pin icon to toggle the auto hide setting of a window.

Step 9 - Layers

Layers are drawing aids intended to help you organize your plot. They are 
like transparent sheets upon which you can draw. In the same way that you 
can view several transparent sheets at once by placing them on top of each 
other, you can hide and unhide layers by choosing which sheets are in the 
stack. 
Quick Start Guide 11
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A simple way to find out the layer to which any object in your plot is 
assigned, just hover over the object with your cursor in any of the 
wireframe views. A tooltip appears listing the object name and its layer. 
This is especially useful when you are working with multiple layers, some of 
which have the same color. 

To create new layers

1 From the Managers menu, choose Layers.

Result: The Layer Database window is displayed.

 

2 To create a new layer, click the New Layer button.

 The New Layer button.

 

 

3 Type a new name for your layer (for example, “Stage”).
4 Choose whether to add the layer to the current scene only or to all 

existing Scenes. (WYSIWYG maintains this setting for the next layer 
that you create.)

5 Click OK.
6 To make a layer and all objects on the layer visible on the plot and in 

shaded views, select the Visible icon. If not selected, the layer is not 
visible and is not, therefore, editable. 
12
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7 To make a layer and all objects on the layer editable on the plot and in 
shaded views, select the Editable icon. If not selected, the layer is not 
editable and is not, therefore, visible.
Tip: You might want to deselect a layer when you are finished working 
with it to avoid possible errors while working on other parts of the plot. 

8 To change the color of the layer, click Color Select. 

Note: It is recommended that you select different colors for each layer 
so as to easily identify the layers on the plot. 

9 To change the line weight of the selected layer, choose the applicable 
thickness from the Line Weight drop-down box. If you leave Default 
selected, the line weight from the Show Options tab is applied to the 
selected layer. The line weight that you select applies to all objects on 
this layer (including library objects, pipes, and truss) and is visible in all 
wireframe views in all modes. 

10 To view the properties of a layer (for example, name, color, and 
inventory of objects drawn on the layer), select the layer and click the 
Layer Properties button.

 The Layer Properties button.

11 Before closing the dialog, set your current layer by highlighting it, and 
then clicking Set Current. Alternately, you can set the current layer by 
double clicking in the first column on the left, beside a layer name.

 The Set Current button.

Note: The current layer is the layer that you are working on at the 
moment – any object that you draw is placed on this layer and assumes 
the layer's default properties when it is drawn. A check mark appears 
beside the name of the current layer.
Quick Start Guide 13



Lesson 1 - Understanding the user interface Release 2024
L

esson 1
12 To view and modify the scenes in which a layer is included, select a 
layer, and then click the Scenes button at the top of the Layer Database.

 The Scenes button.

 

13 Click OK to close Scenes for Layers dialog.
Note: To quickly sort the layers within the layer database, click the 
appropriate column heading in the Layer Database dialog box. For 
example, click the Editable column heading to sort the layers by edit 
setting; that is, those layers marked as editable appear at the top of 
the list in alphabetical order. 
Note: How columns appear in the Layer Database can be edited. The 
order of columns can be changed by clicking on a column header and 
dragging it left or right to the desired position. By right-clicking 
anywhere in the table area, a list is displayed which allows you to 
show/hide columns as you wish. 
14
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Lesson 2 - Creating a set

Introduction

In this lesson you will learn how to:

 insert a venue
 build your set using the following methods:

 from CAD objects
 from library items
 using CAD tools

Step 1 - Inserting a venue

Begin in CAD mode Wireframe tab. This is the mode and layout tab in which 
you create your show drawings. In this example, you will add a Proscenium 
Arch Theatre.

To insert a venue

1 From the Draw menu, choose Venue > Proscenium Arch.

Result: The New Venue - Proscenium Arch window will open.
Quick Start Guide 15



Lesson 2 - Creating a set Release 2024
L

esson 2
2 Accept the default values, and then click OK. 
Result: Your Plan View now contains a plan drawing of a proscenium 
arch theatre. 

Note: Venues are automatically placed on their own "Venue" layer. The 
"Venue" layer is now listed in the Layer Database. 

Step 2 - Coordinate System

Like any CAD software, WYSIWYG builds your model in a three-dimensional 
space. All objects in your drawing will be positioned at an X, Y, Z 
coordinate, which is the distance of the object from the Origin.

Using the Ruler which is displayed along the top and left side of the 
Wireframe view, you can easily find the location of the Origin.

In this file, the center of the Proscenium Arch at the Stage floor level is the 
Origin position.
16
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Note: As you move the cursor around the Wireframe view, you will notice in 
the Status bar that the XYZ coordinate of your cursor's location is 
displayed. Notice that the Z coordinate is always 0 as you move your cursor. 
Since you are looking at the model from a top down view (called Plan View), 
moving your cursor left/right changes the X coordinate, and moving your 
cursor up/down on the screen changes the Y coordinate. Since you cannot 
change the Z coordinate by moving your cursor, you must set the Z 
Coordinate by setting the "Missing Coordinate".

Step 3 - Setting the Missing Coordinate

The Missing Coordinate (X,Y,Z) is the coordinate whose value cannot be 
entered by clicking on the screen. 

In the Status bar, notice that the Missing Coordinate (MC) is set to Z = 0. 
This means that any objects that you insert into your file (while working in 
Plan View) are placed at the X,Y coordinate you define, while the Z 
coordinate must be defined by setting the Missing Coordinate. The X,Y 
coordinate can be defined by clicking or typing in the coordinate values.

To change the Missing Coordinate, while the Wireframe view is selected (i.e. 
click in the view), hit the TAB button and a dialog appears to set your CAD 
coordinate for the Missing Coordinate. Let’s leave it at Z=0 for now.

Step 4 - Building your set from CAD objects

A number of 3D primitives are available from the Draw menu such as 
circles, spheres, cylinders, and risers. In this example, you will insert a riser 
on the stage to have an elevated rectangular area for a drumkit.
Quick Start Guide 17
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To build your set from CAD objects

1 From the Draw menu, choose Riser. 

Result: The New Riser window will open.

2 The New Riser window, specify the dimensions of the riser.
Example: Width 10'0”, depth 10'0”, height 2'0”.

3 Click OK. 
4 The riser needs to be placed in the center along the Y axis, leaving 

space in front of the riser for the other members of the band. Move 
your cursor in the Wireframe view above your stage area, right-click 
and select Bottom Center to insert the Riser from the center of its 
bottom surface, and click to drop the riser into your drawing.

Step 5 - Using the Command Line

The Command Line is an area in WYSIWYG where you can enter 
coordinates for the purpose of placing or editing objects in a document. 
Objects may be placed quickly and with precision by using the Command 
Line.

Coordinates are specified as X, Y, Z. 

In our previous step, we want the riser’s center to be aligned with the 
Proscenium Arch's centreline (and maybe its bottom edge to be 4' upstage 
of the Proscenium Arch’s plaster line). We should remove the previous riser 
and make a new riser at coordinates “0,9,0”.
18
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Using the Command Line to position an object

1 Select the Riser you inserted previously by clicking on one of its lines in 
the Wireframe view.

2 Click the DELETE button on your keyboard, or right-click on it and 
select Delete.
Result: The riser will be deleted.

3 We will now redraw the riser. From Draw menu, select Riser and enter 
the dimensions like you did before, then click OK.

4 This time, rather than clicking with your mouse to define an insertion 
position, start typing "-5, 4, 0" and hit ENTER. 
Result: The riser will be positioned at exact coordinates of “-5, 4, 0”

Step 6 - Inserting library items

Use the items in the WYSIWYG library to build your project. In this 
example, you will add Mannequins with Library Objects to place a band on 
the stage.

To add Band members from library items

1 From the Library menu, choose Browse Library. 

2 Select the Library tool at the bottom of the library browser to ensure 
that you are browsing the scenic library. 

 The Library tool button.
Quick Start Guide 19
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3 Navigate to the desired item, in this case, People & Mannequins > 
Mannequins > With Objects, select a mannequin with an instrument you 
wish to add (e.g. Guitar or Mic Stand), and then double-click to insert. 
Note: To end the insert, either right click and select Finish Insert, or 
press the ESC key on your keyboard.
Tip: You can save time by using the Library Search feature. In the 
Library Browser, simply click the category tab that you are interested in, 
and then type the object name (or part of it) in the Search box at the 
top of the browser panel. All objects that match your query are shown.

4 Insert a Person with Microphone, Person with Electric Guitar, and 
a Person at Keyboard on the Stage.
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5 Now let's add a Drummer with Drumkit on top of the Riser which was 
drawn previously. Press TAB to display the Enter the missing coordinate 
dialog box. 

6 Enter the value for the missing CAD coordinate, for example, 2' (the 
height of the riser), and then click OK.
Tip: As you move your cursor the coordinates are displayed in the 
bottom right corner of the screen. 

7 Insert the Person at Drum Kit on top of the riser.
Result: The Person at Drum Kit will be on top of the riser.
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8 To get a better view of the stage, and make sure the Person at Drum 
Kit is on the riser, we will change our view of the stage. In the CAD 
Options toolbar click the Isometric View button.

 The Isometric View button.

Result: We can clearly see that the Person at Drum Kit is on the 
riser from this view.

Step 7 - Building your set using CAD tools

WYSIWYG is equipped with CAD tools which allow you to draw three-
dimensional models from scratch. In this example, you will draw a a simple 
backdrop that will be lit with a cyc to illustrate some of these tools.

To draw objects using the CAD tools

We will first draw a line. We will later turn the line into a surface to act as a 
backdrop.

1 From the Draw toolbar, select the item that you want to draw, for 
example a Line. 

2 To pick the first point of line, type the coordinates (for this example 
use, -20,20,0), and then press ENTER. 
Note: When you start typing, the Command Line toolbar is activated at 
the bottom of the window. 

3 Specify the coordinates for the end point of the line (for example, 
20,20,0), and then press ENTER. 
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4 Right-click and select Finish Line.

To extrude a line into a surface

1 With the line still selected, from the Tools menu, click Extrude, and then 
choose Lines into surfaces. 

2 The Extrude Lines into Surfaces window will appear.

3 Enter the value for the extrusion distance, 20’, and then click OK.
Result: The line is stretched into a surface.

Switch to the Quad layout tab, by clicking on the Quad tab along the 
bottom, or click on the down arrow at the right side of the CAD mode button 
and select Quad.

The Quad tab divides the workspace into 4 quadrants which display your 
stage from different viewpoints. The top left quadrant displays in a Plan 
View (top) by default; the top right in a Left View; the bottom left in a Front 
View; and the bottom right display is a Shaded View, which is an Open GL 
representation of the model. 
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Using the Quad tab, you can view your file from numerous perspectives all 
at the same time.

Step 8 - Customizing colors and textures

You have designed a simple stage with some band members, but 
everything is very boring and grey. Let's add some color and textures in the 
next steps.

Switch to Quad tab, which offers Wireframe views where you can select the 
object you wish to edit, and the Shaded view in the bottom right quadrant 
is available to visualize the color and texture properties.

To add color to the riser

1 Select the riser by double clicking on it.

Result: The Properties window will open.

2 In the Properties window of the riser, switch to the Appearance tab.
3 In the Elements list along the left side, you will find listed the 6 sides of 

the riser.
4 Highlight all 6 of the elements, and click on the color picker beside 

"Custom Color". Pick a color for the riser, e.g. blue.
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5 Click OK. 
Result: The riser now appears blue in the Shaded view.

Now, let's add a texture to the Stage Floor.
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To add color and textures to the venue

1 Select the Proscenium Arch venue, by double-clicking on any of the 
lines of the venue object. 

Result: The Properties window of the Proscenium Arch will be opened.

2 In the Properties window of the Proscenium Arch, switch to the second 
tab, named Appearance tab.
In the Elements list, all the different elements of the venue object are 
listed (which means you can individually set different properties for 
each element). 

3 For our example, we will only select the Stage Floor element.
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4 This time, select the radio button beside Textures from Library. 
Result: The texture select window appears. 

5 Scroll down to the Wood folder, and select Wood 003.
6 Click Select.
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7 Click OK. 
Result: The Stage Floor now appears with a brown wooden texture in 
the Shaded View.

Note: If you wish, you can experiment with the Stretch and Tiling 
properties for the texture, which will change the appearance of the 
texture in the Shaded View.

Enjoy customizing the rest of your Venue, Stage and Band 
members on your own!
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Lesson 3 - Working with Hang Structures

Introduction

Once the set is in place, you can define your hang structures. 

In this lesson you will learn how to insert a hang structure and define the 
position names in your document.

Step 1 - Defining a position name

Position names are used to identify hang structures. To organize and sort 
the position names, use the Position Manager. 

Note: The order in which the position names appear in the Position Manager 
defines how they are sorted in reports. 

To define a new position name 

1 From the Managers menu, choose Positions. 

2 Click New Position button, and then enter the name of the position.

 The New Position button.

3 Repeat step 2 for all position names as desired. 
4 To sort the position names, use the Up and Down buttons to move the 

selected name in the list. 
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Step 2 - Drawing a pipe

Let's start by setting our layout tab to Quad, this way we can view our 
stage from different viewpoints.

Pipe hang structures can be drawn using the Draw menu.

To draw a pipe

1 From the Draw menu, choose Pipe.

Result: The New Pipe window will open.

2 Choose the associated position name as defined in “To define a new 
position name” on page 29.

3 Specify the Length and Trim Height for the pipe (for this example, 
accept the defaults), and then click OK. 

4 Click or type to place the pipe in your drawing. We will place this pipe 
above our band we created in Lesson 2.
Note: Since the Pipe object has a Trim Height property, this specifies 
its height (position along the Z axis). This is different to the objects we 
inserted on the stage in the previous lesson, where we set the Missing 
Coordinate. 
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Step 3 - Inserting truss

Truss hang structures can be inserted from the library. 

To insert truss

1 Unlike a Pipe which has a Trim Height, Truss will be drawn at the 
Missing Coordinate. Since we wish to insert our Truss at 20', press the 
TAB key on your keyboard, and enter 20' for the CAD Coordinate to set 
this as your Missing Coordinate in your Plan view

2 Ensure that Assembly Snap is enabled in the CAD Options toolbar. (It is 
enabled by default). If it is not enabled, please enable the Assembly snap 
tool before building your truss, so the pieces will be assembled.

 The Assembly snap tool button.

3 From the Library menu, choose Browse Library.
4 Click the Truss tab at the bottom of the Library browser to view the truss 

library 

 The Truss tab button.

5 Navigate to, or search for, the desired piece, and then double-click in 
your drawing to insert it. 

6 Hover your cursor over your drawing where you want to insert the 
object. 

7 Click to place the first piece of truss.
8 To assemble subsequent pieces, hover the cursor over the end of the 

piece of truss you want to attach it to and it will automatically snap into 
position.
Tip: It is easiest to place your first truss on the left side of your screen, 
and continue to build your truss by adding new pieces to the right end.

9 Once the piece has snapped into position, click to insert it into the 
drawing.

10 When you are finished placing truss, right click and select Finish Placing 
Truss.
Note: Since you are in Quad tab, from the side or front view, note that 
the truss is inserted at a height of 20'.

Indicators for truss assembly
When hanging or selecting truss, a 3D indicator appears, displaying a 
directional/positional reference for the individual piece of truss. You can use 
these indicators as a visual guide, helping you to assemble truss structures 
and instantly determine if a truss piece was not assembled as intended.
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Indicators are visible whenever you select truss or when you are in the 
process of assembling/inserting it. When you are snapping a new piece of 
truss to an existing piece, if you see that the indicator for the existing piece 
does not align with the indicator for the new piece, right-click and select a 
different mount point, or roll the truss as necessary (rolling truss usually 
applies to triangular truss or with corner blocks), to ensure that the two 
indicators align.

Naturally, corner blocks and connectors have to be taken into 
consideration. For example, in the truss structure shown below (starting 
from the bottom left-most section and traversing counter-clockwise), the 
two truss pieces along the bottom have matching indicators.

Tips:
 These 3D indicators are in no way related to WYSIWYG’s coordinate 

system.
 It is highly recommended that you build truss structures in Isometric 

view and follow the left-to-right truss assembly rule.
 When a truss structure is completed, as long as the indicators for all 

the component pieces align (taking into consideration corner blocks 
and connectors, fixtures will hang correctly from this structure. 

Note: For more information on how to assemble truss, please refer to the 
"Hanging Truss" section in the Reference Guide.
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To assign a position name 

1 Double-click the truss structure to open its Properties window.

2 On the Hang Structure tab, from the Name drop-down box, select the 
desired name. 

3 Click OK.

To insert Truss Vertically

Truss can be inserted on the Floor standing on one of its ends.

1 From the Library Browser, in the Truss tab, locate a straight section of 
Truss, e.g. Christie > Type A > 12x12 8ft.

2 Right-click on the Truss name in the Library Browser and select one of 
the Insert Vertical options. The rotation angle selected will determine 
the direction that the truss' Ladder side will face.

3 Move your cursor over the drawing area, and click to insert the Fixture.
Note: When Truss is inserted vertically in Plan View, the Missing 
Coordinate defines the height the truss’ base is inserted.
Quick Start Guide 33



Lesson 3 - Working with Hang Structures Release 2024
L

esson 3
34



March 2024  Lesson 4 - Hanging and focusing fixtures
L

es
so

n 
4

Lesson 4 - Hanging and focusing fixtures

Introduction

After inserting hang structures into your drawing, you are now ready to 
hang and focus fixtures. A library of fixtures is available for you to choose 
from. 

In this lesson you will learn how to:

 Insert fixtures
 Focus fixtures
 Relocate and Clone fixtures

Note: You can only focus conventional fixtures in CAD mode.

Step 1 - Inserting fixtures

Fixtures are objects on the plot which can be hung on a hang structure, or 
inserted on the floor.

To hang fixtures

1 In CAD mode in Wireframe view, from the Library menu, choose Browse 
Library. 

2 Select the Fixtures tab at the bottom of the Library Browser, to ensure that 
you are browsing the fixture library. 

 The Fixtures tab button.

3 Navigate to the desired item, right-click, and then select Insert. For this 
example we will select Source 4.

4 Move the mouse over a hanging structure (i.e. pipe or truss) and click 
to hang the fixture. We will hang the Source 4 on the pipes created 
previously in lesson 3.
Quick Start Guide 35



Lesson 4 - Hanging and focusing fixtures Release 2024
L

esson 4
5 Place 8 Source 4 on the pipe. When you have finished placing the 
fixtures, right click and select Finish Placing Fixtures. 
Result: The Source 4 fixtures will be inserted onto the pipe.

Tip: Whenever you hang fixtures on a truss, it is always best to work in 
Isometric View and Zoom In to make precise fixture placement on 
specific truss chords.

Inserting Fixtures on the Floor
Automated Fixtures can be inserted on the floor, which does not require 
using a Pipe or Truss.

1 From the Library Browser, in the Fixtures tab, locate an Automated 
Fixture, such as a Clay Paky Sharpy.

2 In the Library Browser right-click on the Fixture name and select Insert on 
Floor.

3 Move your cursor over the drawing area, and click to insert the Fixture.
Note: When inserting Fixtures on floor, they will be placed at the 
specified Missing Coordinate height.

Step 2 - Focusing fixtures

There are three methods for focusing fixtures: 

 clicking and dragging the light beam of the selected fixture 
 changing the pan and tilt values by double-clicking to access the 

fixture’s properties box
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 inserting focus objects, such as a Focus Position, a Focus Line or a 
Focus Arc.

To manually drag a fixture’s light beam

1 In CAD mode in Wireframe view, click on a fixture.

Result: The fixture will be selected. The fixtures beam will appear.

2 Click and drag the beam to where you want it positioned.
Quick Start Guide 37



Lesson 4 - Hanging and focusing fixtures Release 2024
L

esson 4
To focus a fixture using its properties

1 In CAD mode in Wireframe view, double click on a fixture.

Result: The Properties window of the fixture will appear.

2 In the Fixture tab, in the General subtab, look Pan and Tilt fields. These 
values correspond to the focus drag of the fixture. By changing these 
values we change the position of the beam.

3 In the Pan field, enter in 30.
4 In the Tilt field, enter in 45.
5 Click Apply.

Result: The fixture will move according to the values entered changing 
the beams location.

Focus Objects allow you to focus one or more fixtures to a specific Focus 
Point in space (i.e. coordinate at which the Focus Position was inserted). Or, 
it will allow the focus of multiple fixtures to be evenly spread along a Focus 
Line or Focus Arc.
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To insert a Focus Position

1 From the Draw menu, choose Focus Position. 

2 The New Focus Position window will open.

3 In the Name field, type a label for the new focus position and then click 
OK. For this example call it “Lead Singer”

4 Press TAB to adjust the Missing Coordinate, if necessary. 
5 Click to place the focus position in the drawing. Place this one over the 

Person with Microphone created in Lesson 2.
6 Create additional focus positions for the Person with Electric Guitar, 

Person at Keyboard and Person at Drum Kit.

Focus Lines and Focus Arcs
Focus Line and Focus Arc are special focus objects which multiple 
conventional fixtures can be assigned to, and spread out evenly across the 
object, or focused to the vertices (in the case of a Focus Line).

To insert a Focus Line

1 From the Draw menu, choose Focus Line.

Result: The New Focus Line window appears.
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2 In the Name field type a name for the new Focus Line.
3 In the Layer drop-down menu select the layer on which you want to 

draw the Focus Line.
4 Select the focus type.
5 Click OK.
6 Draw your Focus Line as required.

To insert a Focus Arc

1 From the Draw menu, choose Focus Arc.

Result: The New Focus Arc window appears.

2 In the Name field type a name for the new Focus Arc.
3 In the Layer drop-down menu select the layer on which you want to 

draw the Focus Arc.
4 To drawn the focus arc free hand, click Interactive. To pre-construct the 

focus arc, enter in the radius, start angle and end angle details, then 
click OK.

5 Place your Focus Arc as required.

Step 3 - Focusing fixtures using focus positions

Note: Focus Objects will also work with Automated Fixtures, and can be 
used with the Focus Designer tool. This will be covered in a Lesson 6 - 
Building lighting Looks in Design mode. 
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To assign fixtures to a Focus Position

1 In CAD mode in Wireframe view, from the Tools menu, choose Quick 
Tools > Quick Focus.

2 Click on the focus position to set it as the active focus position. For this 
example, select the Lead Singer Focus Position 

3 Click on the desired fixture(s) to set there focus to the selected Focus 
Position. In this example click all the Source 4 fixtures.

4 When you are finished focusing fixtures, right-click and select Finish 
Quick Focus.
Result: All the fixtures will be focused on the Singer Focus Position.

To assign fixtures to a Focus Line

1 In CAD mode in Wireframe view, from the Tools menu, choose Quick 
Tools > Quick Focus.

2 Select the fixtures you want to focus and also select the Focus Line to 
which you want to assign conventional fixtures in CAD mode.
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3 When you are finished selecting, right-click and select Finish Quick 
Focus.
Result: The fixtures will be focused along the Focus Line

To assign fixtures to a Focus Arc

1 In CAD mode in Wireframe view, from the Tools menu, choose Quick 
Tools, Quick Focus.

2 Select the fixtures you want to focus and also select the Focus Arc to 
which you want to assign conventional fixtures in CAD mode.
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3 When you are finished selecting, right-click and select Finish Quick 
Focus.
Result: The fixtures will be focused along the Focus Arc.

Step 4 - Relocating or cloning fixtures

Move or copy multiple fixtures at once from one hang structure to any other 
hang structure in Wireframe. The steps to use Relocate Fixtures and Clone 
Fixtures are the same.

Tip: Whenever you relocate or clone fixtures from one truss to another 
truss, it is always best to work in Isometric View and Zoom In to make 
precise fixture placement on truss chords.

To relocate or clone fixtures

1 In CAD mode in Wireframe view, select two or more fixtures on a hang 
structure.

2 From the Edit menu, choose Relocate Fixture to move fixtures or Clone 
Fixtures to copy fixtures.
Tip: You can right-click on the selected fixtures, then choose Relocate 
Fixtures or Clone Fixtures from the menu that appears, or use the 
corresponding keyboard shortcuts CTRL+X or CTRL+C.
Note: For these functions to work, only select fixtures on a single hang 
structure or the same chord of a truss.
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3 Hover over the target hang structure to where you want to relocate or 
place the copied fixtures.
Result: 

Line markers appear on the target hang structure to indicate where the 
fixtures will be placed after the move or copy is completed.

OR

Red X markers appear if:

 The target hang structure does not have enough space for the 
selected fixture.

 The Enforce Minimum Spacing value set in Document Options > Hang 
Structure Settings is considered when placement is validated.

4 (This step is optional.) With fixtures on the cursor, right-click to select 
and enable any of the functions from the menu that appears.
 Reverse Direction: Relocated or cloned fixtures are placed in the 

opposite direction from their original locations.

 Flip Pan: The Pan angles of the relocated or cloned fixtures are 
flipped by 180°.

Example: When a fixture with Pan angle set to -30° is relocated, its 
Pan angle will change to 150°.

 Hang Fixtures on Hang Position 1: Relocated or cloned fixtures are 
placed on the bottom truss chord of the same truss.
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 Hang Fixtures on Hang Position 2: Relocated or cloned fixtures are 
placed on the top truss chord of the same truss.

Notes: 
 The functions remain enabled until they are disabled.

 Reverse Direction and Flip Pan can fix the focus and orientation of 
fixtures if reversed after relocating and cloning.

 Reverse Direction and Flip Pan can be used at the same time.

5 (This step is optional.) With the fixtures on the cursor, right-click and 
select Remove Resulting Fixtures’ Attributes from the menu that appears. 
Selecting this option will clear the fixture(s) of attributes after clone or 
relocation.
Notes: 
 The Unit number will be assigned to the cloned or relocated 

fixture(s) automatically if the target hang structure is a Pipe and the 
AutoUnit checkbox in the Hang Structure Settings tab of Document 
Options is selected.

 If you select Remove Resulting Fixtures’ Attributes menu, Mode, Lens, and 
Lamp attributes will not clear.

 If you selected Remove Resulting Fixtures’ Attributes menu during a 
previous Relocate/Clone operation, it is not selected for the next 
operation.

6 Click to drop and place the fixtures on the target hang structure.
Result: The selected fixtures are moved or copied to the target hang 
structure.

Notes: 
 Conventional fixtures maintain their original focus and orientation 

after you relocate or clone.

 You can relocate or clone to and from different types of hang 
structures if they fit the target space.

 You can relocate imported fixtures from collinear pipes to other 
hang structures.
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Lesson 5 - Assigning fixture attributes

Introduction

In this lesson you will learn how to assign control data and physical details 
of fixtures, including colors and gobos. You will also learn how to change 
and otherwise manipulate this data, which is referred to as “Fixture 
Attributes”. 

Step 1 - Assigning attributes to fixtures

Once you have determined what fixtures you wish to use for your show and 
where to place them, you will likely need to define how they are to be used. 

Example: What circuit will a conventional fixture be plugged into? 
What dimmer will that circuit be connected to? What channel on your 
console will control the intensity of this dimmer/fixture? Will this 
fixture require a gel, a gobo, both, or some other accessories such as 
a set of barndoors, a tophat, a scroller, etc.? How will your 
automated and LED fixtures be patched?

Once you have made these decisions, you may assign the necessary 
Fixture Attributes in one of three ways: 

 By using Quick Tools.
 By accessing the fixture’s properties and entering data into the fields 

found on the various sub-tabs under the Fixture tab.
 By entering the information into one of the spreadsheets.
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Quick Tools

To use Quick Tools to assign attributes to fixtures

1 Working in the Wireframe view, go to the Tools menu, Quick Tools > 
Quick Tools launch Quick Tools.

Note: Quick Tools can also be opened by pressing the Q key on your 
keyboard, or clicking the Q button on the Tools toolbar.
Result: The Quick Fixture Tool window will open.
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2 Click the + button beside each heading (Control Data, General Details, 
Accessories) to access the attributes they contain.

3 Mark the checkbox next to the attribute(s) you wish to assign.
4 Type or select the details required for each attribute and mark the 

checkboxes for any required incrementing options.
Note: You may choose to apply only one or any number of attributes at 
once. In order to avoid potential problems though, it is recommended 
that you do not assign more than a handful of attributes at the same 
time.
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5 Click OK to start the Quick Tools session.
Result: The Quick Fixture Tool window will close. A “Q” appears near the 
cursor. If Instruction Tooltips are enabled (Options >Application 
Options, in the General tab) the tooltip near the cursor shows what 
details are going to be assigned to the next fixture you click on. The 
same information can also be found on Status bar at the Prompt Line.

 

Note: As you hover over a fixture in the wireframe, the fixture will be 
highlighted orange. This is to indicate the attribute(s) you have just 
defined will be assigned to that specific fixture once you click on it.

6 Click on the required fixture to assign the desired attribute(s) to it. 
Result: If sound is enabled on your computer, a “Beep” will sound to 
confirm that the selected attribute(s) have been applied. If any 
incrementing options were selected, the Instruction Tooltip and Status 
bar will update to show the new values that are going to be applied to 
the next fixture you click on.

7 Repeat Step 6 for all fixtures you wish assign attributes to.
8 Once you’re done assigning attributes for this session, press the Enter 

or Esc key to complete the session.
Note: The session can also be completed by right-clicking and selecting 
Finish Quick Tools. 

Note: 

 After using Quick Tools to assign attributes to a fixture, you may click on 
the same fixture again, during another Quick Tools session. The current 
Quick Tools session will override the previous.

 Patch control data must fulfill the requirements of patch notation, which 
is “[universe_name].[DMX_address]”.

 After clicking to assign attributes to a multi-circuit or multi-patch 
fixture, a dialog appears, listing the circuit names to which you can 
assign the selected Attributes. You may select any number of circuits, 
then click Select to actually assign the attribute(s). 

 When using Quick Tools to insert a color or gobo, WYSIWYG 
automatically inserts the default color frame or gobo holder defined for 
that fixture.

Quick Tools increment feature
The Auto Increment and Custom Increment options found in the Quick Fixture 
Tool window can be enabled in order to assign sequential data to fixtures. 

Example: If you enable Auto Increment for the Unit and Dimmer 
attributes, Quick Tools will automatically assign the next logical 
number to the next fixture you click on, starting with the value that 
entered in the Quick Tools window. One of Auto Increment’s most 
useful purposes is assigning Patch data.
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Using the Quick Tool Increment feature

1 In Wireframe view, press Q to open the Quick Tools window.

2 Expand the Fixture Data section and mark the Patch checkbox.
3 In the Patch field, enter the name of the DMX universe to which you 

wish to patch the fixture, followed by a period (.) and then by the 
starting DMX address. 

Attention: Ensure that there are no spaces anywhere in this field.
4 To the right of the Patch field, mark the Auto Increment checkbox.
5 Click OK.
6 Click on the first fixture in the patch sequence.

Result: The patch value is assigned to the fixture and the Tooltip and 
Status bar change to show the next patch value. If, for example, the 
fixture you just clicked on requires 17 DMX channels, and you started 
the patch at A.1 (i.e. Universe “A”.DMX Address “1”) the patch value 
that now appears in the Instruction Tooltip is A.18. This patch value will 
be assigned to the next fixture you click on.

The Auto Increment option works the same for all attributes where it can be 
enabled. When enabled, values will increase by increments of 1. Please 
consult the WYSIWYG Reference Guide for information on how to use the 
Multi-Cable option for Circuits.

Using the Quick Tool Custom Increments
Custom Increments are used for assigning sequential Pan, Tilt or Spin angles 
to fixtures. 

Attention: In this example, you will focus Par fixtures on a bar of six 
panned 10º apart from each other but tilted at the same 45º angle.

1 In the Quick Fixture Tool window, in the Fixture Attributes section mark 
the Focus checkbox.

2 Mark to select the Pan/Tilt/Spin radio button.
3 To the right of the Pan value field, mark to check the Custom Increment 

checkbox .
4 In the Custom Increment field for Pan, enter 10.
5 In the Tilt field, enter 45. 
6 Click OK.

Result: As you click on each fixture on your bar of six, their Pan and 
Tilt will change to the values displayed in the Instruction Tooltip before 
you clicked.
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Changing Quick Tools options mid-session
It is possible to change any of the attribute details while within a Quick 
Tools session. 

Example: If you wish to assign the same Dimmer number to the 
next conventional fixture, but you’ve enabled Auto Increment for 
Dimmers, here is how:

1 Press the Q key on your keyboard, or right click and select Change 
Quick Tools Options. 

Result: The Quick Fixture Tool window will open. 

2 In the Quick Fixture Tool window, make the necessary changes to the 
attributes.

3 Click OK to resume the session.

Fixture Properties
Another way to assign attributes to fixtures is by their Properties window. 
Since this method involves quite a lot of clicking, it is best used for fixtures 
that are in some way unique (i.e. they do not follow any of the “patterns” 
that can be defined or achieved by using Quick Tools) and/or to view, update 
or modify Attributes that have already been assigned. To use a fixture’s 
Properties window:

To assign attributes to fixture by the Properties window

1 In Wireframe view, double-click on a fixture which you have assigned 
one or more attributes.

Result: The Properties window opens.
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2 In the Properties window, click the Fixture tab.

3 Various attributes of the fixture can be found under the sub-tabs 
General, Beam Options, Patch and Cuts. These attributes can be modified 
as desired.

4 To apply the changes and keep the Properties window open, click Apply. 
To close the Properties window and apply changes, click OK. 

Attention: Clicking Cancel will close the Properties window without 
applying any changes, except for changes made before the Apply 
button was last clicked.

In order to avoid mistakes, it is best to open the Properties window of fixture 
for a single fixture at a time. 

However, should you wish to access the properties for multiple fixtures at 
once, simply select the fixtures, right-click and then select Properties or 
press ALT+Enter. If multiple fixtures (regardless of type) are selected, 
modifying one or more attributes via the Properties window results in all 
selected fixtures having the new values applied to them. 
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Spreadsheets
As you place fixtures into your file in the CAD wireframe, WYSIWYG 
automatically adds them to its internal spreadsheet. The spreadsheet is 
always synchronized with the wireframe, so any changes made in one will 
be reflected in the other immediately. In other words, if you were to delete 
a fixture from the Spreadsheet view, it would disappear from the Wireframe 
view as well—and vice-versa.

To access the spreadsheet, simply click a view tab which contains a 
spreadsheet (such as the Spreadsheet tab in DATA mode). 

The Spreadsheet view contains not only the full inventory of all the fixtures 
in your file, but all of their attributes’ values, as well as other information—
some of which is only available in spreadsheets, such as fixtures’ absolute 
position in 3D space or the type of Circuit they require. Each row in the 
spreadsheet represents a single fixture, or a single cell/circuit of a multi-
cell/-circuit fixture, or a single electronic accessory associated with a 
fixture, while each column contains the values of fixture attributes. 

A Fixtures’ visibility in the spreadsheet is controlled by layers’ visibility (i.e. 
if a layer is not visible, then any fixtures that reside on that layer will not be 
visible either). The visibility is also controlled by the Show Selected Only 
option (i.e. when this option is enabled on the Spreadsheet toolbar or in the 
View Options of the spreadsheet, only fixtures selected in a wireframe will 
appear in the spreadsheet). Please note that layers supercede the Show 
Selected Only option: when a layer is turned off, it is impossible to select 
anything it contains. Attributes’ (i.e. columns) visibility is controlled from 
the spreadsheet’s View Options, as follows:
Quick Start Guide 53



Lesson 5 - Assigning fixture attributes Release 2024
L

esson 5
To modify the columns of a spreadsheet

1 From the Options menu, choose View Options.
Result: The View Options window will appear. 

Note: You can also right-click on the spreadsheet shortcut and select 
Properties. 

2 Click the Data Options tab.

3 To remove a column from the spreadsheet, under the Column Options 
heading, unmark the checkbox next to that column’s name.

4 For the changes to take effect, click OK.

To modify fixture attributes directly in the spreadsheet

1 Click the cell that represents the fixture and attribute you wish to 
modify.

2 Type the new value or select it. 
3 Press Enter on the keyboard.

Result: The value is assigned to the fixture attribute.

It is also possible to assign the same value to multiple attributes at the 
same time. For example, if you wish to assign the same colour to multiple 
conventional fixtures:
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To modify the attributes of multiple fixtures simultaneously

1 Select the cells under the column you want to modify. For this example, 
select all the cell in the Color column.

2 Enter in the new value. For this example, type R57 (for Rosco 57 
“Lavender”). 

3 Press Enter on the keyboard.
Result: The value is assigned to the fixture attribute. A Rosco 57 gel is 
added to each fixture whose Color cell you selected.

Step 2 - Choosing data

To choose data

1 In some columns a drop-down is available which lists relevant data. 

Example: The Color column, a drop-down will appear displaying 
some options to help you enter the data into the cell(s). 

2 If you wish to browse the library, select "Pick from Library".
Result: This action opens the Color Select window where you can browse 
the gel catalog to select your color.

Step 3 - Entering sequential numerical data

To assign a sequential patch for a list of fixtures, you can use incremental 
data entry to facilitate your work. WYSIWYG will calculate the next available 
value based on the number of required channels for the previous fixture. 

To enter sequential numerical data

1 Select the fixtures you wish to patch sequentially by click and dragging 
their cells to select them.

2 Enter the starting patch in the following format, “Universe 
Name.Starting Address +”. 

Example: Type “A.1 +” and then press ENTER. 
Quick Start Guide 55



Lesson 5 - Assigning fixture attributes Release 2024
L

esson 5
Step 4 - Filtering and modifying data

Any attribute associated with a fixture in your WYSIWYG drawing (for 
example, purposes, control channels, focus positions) is available for you to 
edit in Data mode. Any changes that you make are reflected throughout 
the entire file, including the drawing.

Begin in the spreadsheet. You can use data filters to quickly locate data in 
the spreadsheet.   

To use a data filter

1 In the Spreadsheet view, locate the Type column and specify a filter to 
locate the fixtures you want to work with.

2 In the Filter bar, enter the text "Fresnel" to filter the Spreadsheet.
Result: The spreadsheet refreshes, displaying only the fixtures that 
meet the filter criteria.

3 Make any data changes that you require. To add or modify information, 
enter the data in the appropriate cell. You can add or modify chunks of 
information at the same time by selecting a series of cells and typing 
and then hit ENTER.

4 To remove the filter, just click on the X button displayed on the right 
side of the Type column, beside the filter text you entered.
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Lesson 6 - Building lighting Looks in Design 
mode

Introduction

Design mode offers a creative environment for lighting designers to use the 
design tools to experiment with lighting, video and automation to create 
cue concepts. You can create static looks, export them as images or render 
them for design presentations. 

Design mode is intended so you do not need channel numbers or a patch. 
You can simulate cross-fading between lighting looks without the need of a 
lighting console by using the shortcut properties in the shortcut bar to 
specify the fade time in seconds. This is the amount of time that it takes to 
“fade” to this look when you click on it from another look in the shortcut 
bar.

Once you create the Look and specify the fade time, you can use the design 
tools to customize the Look. When you switch from one Look to the next, 
you can see the movement of the lights from one position to the next, along 
with any changes you have made between Looks, such as color, intensity, 
and so on. 

In this lesson you will learn how to build a lighting Look in Design mode and 
cross-fade to another lighting Look. 

Step 1 - Fixture selection in Shaded view

To create a Look, you will have to select and manipulate fixtures in Shaded 
view. A fixture can be selected from the Shaded view similar to how fixtures 
can be selected in Wireframe view. This step will teach you how.
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To activate Shaded View Selection

1 In a Shaded view in CAD, Live or Design mode (meaning the amber 
outline appears around the Shaded view), press TAB once. You are now 
in Shaded View Selection mode.

2 To select a fixture in Shaded view Selection mode, click directly on a 
fixture’s image in the Shaded view:

3 To select multiple fixtures in Shaded View Selection, press CTRL and 
click each fixture that you want to select. 
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You can also select multiple fixtures at once by drag-selecting with the 
mouse as you would in wireframe modes; Shaded View Selection 
disables the camera movement controls so you can drag a marquee box 
around fixtures to select them.

4 Once you are finished selecting fixtures, press TAB again to exit from 
Shaded View Selection mode. You will then regain control of the Shaded 
View camera.
Tip: 

 It is helpful to keep your hand near the TAB key while selecting fixtures 
and maneuvering around with the camera; once you need to move 
around your view, press TAB to exit Shaded View Selection. Your fixture 
selection is maintained as you move in and out of the Shaded View 
Selection mode.

 Make sure while you navigate around in the Shaded view that you give 
yourself a good angle on the view in which you want to select fixtures. 
It may be difficult to select a fixture in the middle of a lighting position 
or truss while you’re looking at a side view of it.
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Step 2 - Creating a new lighting Look 

To create a new Look

1 In the Looks shortcut bar area, right-click and select New Look. 

Result: The Enter new Look name window will open.

2 In the Enter new Look name window, type the name of the new Look (for 
example, Scene1).

3 In the Fade time box, type the fade time in seconds for this Look, and 
then click OK. 

4 Create another Look in the same way, this time with a different Look 
name. Customize both Looks in the following steps.
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Step 3 - Using the Intensity tool

To use the intensity tools

1 In your drawing, select the desired fixtures.

2 On the Design toolbar, click the Intensity Designer Tool button. 

 The Toggle Intensity Designer Tool button.

Result: The Intensity window will open.

3 Click the dial, and then move the mouse up or down to set the intensity 
level, or use the up/down arrows for single increment/decrements. 

4 Click the buttons for setting intensity to Full (100%), Half (50%) and Off 
(0%).

5 You can set increment/ decrements by 5%, 10% or 25% and adjust the 
intensity by using the + (plus) or — (minus) buttons.

Note: The Zoom and Iris tools work the same way. 
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Step 4 - Using the Focus tool

To use the focus tool

1 On the Design toolbar, click the Focus Designer Tool button. 

 The Toggle Focus Designer Tool button.

Result: The Focus window will open.

2 To focus automated fixtures, with the fixtures selected, choose from 
any of the following methods:
 Use the Home button to focus the fixture back to its home position, 

which resets the fixture to pan = 50% and tilt = 50%.
 Click the Focus button, and then click in the Wireframe view at the 

point where you would like to focus the beam.
 Choose a focus from the Focus Objects drop-down list. 
 Use the Focus Pad by clicking on the pad, and then moving the 

mouse.
 Use the Pan wheel and Tilt wheel to control pan and tilt of the fixture.
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Step 5 - Using the Color tool

To use the color tool

1 On the Design toolbar, click the Color Designer Tool button. 

 The Toggle Color Designer Tool button.

Result: The Color window will open.

2 To assign color, with the desired fixtures selected, click to pick a color 
on the palette or the color wheel.

3 If desired, you can use the RGB drop-down boxes to manually enter 
RGB, CMY, or HSI values.
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Step 6 - Using the Gobo tool

To use the gobo tool

1 On the Design toolbar, click the Gobo Designer Tool button. 

 The Toggle Gobo Designer Tool button.

Result: The Gobo window will open.

2 To assign a gobo, with the desired fixtures selected, select the desired 
wheel from the drop-down list, and then use gobo selection arrows to 
choose the desired gobo. 

Note: The Prism toolbar work the same way. 

Step 7- Cross-fading between lighting Looks

After setting up at least two lighting Looks, you can “fade” between them 
by using the cross-fade feature.

1 Ensure that the Fade Looks button is enabled so the Look fades instead 
of jumping directly to the next Look. 

 The Fade Looks button.

2 To watch the “fade” from the first Look to the second Look, click the 
shortcut for the second Look. The image fades over the period of time 
that you specified as the fade time for the second Look. 
Tips: 
 For a more realistic view of the fading between Looks, click the 

Shaded tab.

 To jump directly to a specific Look, right-click the Look, and then 
select Jump to.

Step 8 - Using CueLists

Cuelists enable you to play back stored Looks in any order, without having 
to manually start the crossfade function described in the previous section.
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To create a Cuelist

1 On the Design toolbar, click the Cuelist Editor Tool button to open the 
Cuelist tool.  

 The Toggle Cuelist Editor Tool button.

Result: The Cuelist Editor window appears.

2 The Cuelist Editor window, click the Create a new Cuelist button.

 The Create a new Cuelist button.

3 In the window that appears, type a name for the Cuelist, and then click 
OK.

To add a Look to a Cuelist

1 Once you add a cue, you can assign a Look to it by clicking the drop-
down in the Look column and selecting the appropriate Look.

2 In the Trigger column, set the trigger to Follow or Go 
 Go - The fade for the current cue will start immediately (the delay time 

is 0 seconds).
 Follow - The fade for the current cue will activate automatically after 

the set delay time has passed.
3 In the Fade column, set the Fade time. A Fade is the time (in seconds) 

that it takes to transition between the previous cue and the current cue.
4 In the Delay column, set the delay time. A delay is the time (in seconds) 

that it takes for lights to start fading into the current cue.
5 Once a few Looks have been added in the desired order, and the fade/

delay times have been set, click on the GO button to watch the Cuelist 
play.

For more info on Cuelist, please refer to the Section “About Cuelists” in 
WYSIWYG Reference Guide.
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Step 9 - Opening the Render Wizard

The Render Wizard steps you through the process of generating a rendering 
of your drawing.

To open the Render Wizard

1 With the desired lighting Look active, open the Render Wizard by clicking 
on the appropriate tool on the designer toolbar. 

 The Render Wizard button.

2 In the right pane, click and drag the mouse to set up your image.
3 In the left pane proceed through the Wizard steps by using the Next 

and Back buttons. 

Note: By default, the Background Rendering Manager runs on the same 
system as WYSIWYG. You can also run it on a separate machine. For 
details on how to set this up, please refer to the Background Rendering 
Manager section of the WYSIWYG Reference Guide.

For more information on the options available for rendering, consult the 
WYSIWYG Reference Guide. 
66



March 2024  Lesson 7 - Creating and modifying reports
L

es
so

n 
7

Lesson 7 - Creating and modifying reports

Introduction

In Presentation (Pres) mode, a series of pre-formatted reports is available 
for you to use as is or to modify to suit your needs. Unlike the spreadsheets 
in Data mode, you cannot edit fixture data in these reports. You can, 
however, modify the setup and layout of these reports. 

In this lesson you will learn how to work with reports. 

Step 1 - Entering show information

Shortcuts to the pre-formatted reports in Presentation mode are available 
in the shortcut bar. Click the desired report shortcut to open it. Show 
information such as venue, designer, show, and assistant is displayed at the 
top of each report. 
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To add or modify show info

1 From the Options menu, choose Document Options.

Result: The Document Options window will open.
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2 Click the Production Team Info tab.

3 Click in the Value column and make the necessary changes or additions 
(for example, add John Smith as the lighting designer).

4 Click OK. 
Note: Use the Filter above the top to reduce the rows displayed in the 
table. For example, select "Show Favorites Only" to display most 
commonly used Production Team Info names. Click on the Fav column 
to add/remove a name from Favorites list.
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Step 2 - Modifying a report

To modify a report

1 In Presentation mode Reports view, in the shortcut bar, click a shortcut 
to open a report.

2 Right-click in the open report, and then choose View Options. 
Result: The View Options dialog opens with the General and Report tabs 
available. 

3 Click the Report tab. 

Group By

The Group By drop-down list enables you to select a data field for 
grouping the data. These groups appear as separate tabs at the bottom 
of a report. Choose None to have all information displayed on the same 
page.

Columns
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The Columns list displays the columns available for inclusion or exclusion 
in a report. You can display the fields in any order by arranging the 
order of this list using the Up and Down buttons. The top of the column 
list represents the left column on the page and the bottom of the list is 
the right column. To move a column up or down the list, click the 
column name and then use the Up/Down buttons. 

Sort By

The Sort By list contains the settings for how the report is sorted. The 
keys that you specify are sorted in alphabetical or numerical order. 
When fixtures have the same value in the first sort key, the report is 
then sorted by the second sort key, and so on for the third sort key. 

When you have set all the options, click OK to save and exit. The report 
refreshes and any changes are reflected immediately.

Step 3 - Formatting report headings

To format the report headings 

1 In the report, select the text to be formatted.

2 From the Text toolbar, choose the desired alignment, font, text color, 
and cell fill options.

3 From the Report menu, select Format Cells, and then adjust the cell 
format, cell border, text alignment, font, and background colors as 
desired. 
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4 Select a Smart Cell drop-down and then choose the desired variable, as 
shown in the following graphic:

5 From the File menu, choose Save.

To format the report data

1 In the report, the cells below the column heading is the report data. 

2 To format any of the columns, select a cell within a column, and then 
use the Text toolbar, to set desired alignment, font, text color, and cell 
fill options.
Alternatively, right-click on the data section and select Format Cells. 

Note: To format cell borders, it is offered only from within the Format 
Cells dialog.

3 To turn on Zebra Striping, go to Report menu and select Zebra Striping.
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4 Once you've completed your formatting changes, save your file.
Result: With some formatting to cells, and moving some of the data 
through copy/paste and row/column manipulation, you can customize 
the look of your Report.
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Lesson 8 - Working in the New Plots view

Introduction

New Plots views were introduced so that you could more effectively 
manipulate a drawing developed in CAD mode to create a lighting plot, or 
“schematic”, for printing. 

Note: You cannot change the properties of items that you have inserted in 
CAD mode; you can only change the properties of items that you have 
inserted in the New Plots view.

In this lesson you will learn how to work with New Plots. 

Step 1 - Creating a New Plot

To create a New Plot

1 In Presentation mode, click the New Plots shortcut tab.

2 Right-click in the New Plots shortcut area, and then choose the type of 
plot that you want to create.

3 Type a name, and then click OK.
Note: By default, empty layouts are set up to use 24” x 36” sheets of 
paper. 
Quick Start Guide 75



Lesson 8 - Working in the New Plots view Release 2024
L

esson 8
To modify the paper size

1 In your New Plot, right-click in the report area, and then choose View 
Options. 

Result: The View Options window will open.

2 From the Paper Size drop-down list, select the desired paper size. 
3 Click OK to save and exit.

Next, you can determine the parts of the drawing that you want to see on 
the page by moving the page. 

To move the page

1 Right-click in the New Plots work area, and then choose Move Page. 

Result: The cursor turns into a hand symbol.

2 Hold down the left mouse button to grip the page and drag to move it 
until the parts of the drawing that you want are contained within the 
grid area. 

3 When you are finished, right-click and choose Finish Move Page. 
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Step 2 - Manipulating objects on the plot

A New Plot is a snapshot projection of your CAD drawing. Once the 
snapshot is taken, you can modify objects on the New Plot without affecting 
the original CAD drawing.

Tip: Zoom in by pressing PAGE UP or by using the middle mouse button to 
facilitate the set-up. 

To manipulate the objects on a plot

1 In the New Plot, select an object.

2 Click and drag to modify its position; to modify the layer properties, 
right-click the object, and then choose Object Properties. 

3 Modify the properties as required.
4 Click OK.

Step 3 - Plotting non-horizontal hang structures

In the New Plots view, you can rotate non-horizontal hang structures, such 
as booms and ladders, around their base to show all mounted fixtures. This 
rotation can be right, left, top, or bottom. 

To plot non-horizontal hang structures

1 Select the hang structure.

2 Right-click and select Rotate Position.
3 The Rotate Position window will open.

4 Select the direction and angle in which you want to rotate the hang 
structure.

5 Click OK. 
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Step 4 - Inserting objects

You can add objects to the plot for notation by simply drawing or selecting 
them from the Draw menu. Objects that you can draw include lines, arcs, 
circles, and text labels. You can also insert symbols from the Library 
Browser.

To insert objects

1 From the Draw menu, choose the object that you want to insert. 

Note: Choosing Symbol opens the Library Browser. 
2 In the properties box that opens, type the properties of your object.

Note: If you choose Interactive, you can change the size of the object 
manually.

3 Click OK, and then click in the plot to place the object.
Tip: You can resize objects by clicking and dragging them.

To add arrows to lines

1 Select the line to which you want to add one or more arrows.

2 Right-click and select Object Properties.
Result: The Properties window will open.
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3 Click the Line tab. 

4 Select where you want the arrows to appear, either at the start or end 
of the line, or both places.

5 Click OK.

To change a single line to a double line

1 Select the line that you want to modify.

2 Right-click it, and then select Object Properties.
3 Click the Line tab. 
4 Select the Double Line check box.
5 Click OK.
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Lesson 9 - Creating and modifying layouts

Introduction

In WYSIWYG, the Layouts tab offers the tools to define all the information 
you wish to display on your to printed lighting plot. Layouts are created in 
WYSIWYG by arranging various CAD, report, image, and other items on a 
defined paper size. 

A layout may contain multiple objects/items of the same type. For example, 
you can place multiple CAD items on the same layout, in order to show the 
lighting plot from the multiple viewpoints (i.e. Plan view and Side view) or 
even to show the same viewpoint at different scales (for example, if you 
need to show the detail of a particularly “dense” or “complex” area of the 
plot, where the scale of the CAD item simply displays the fixtures, etc., too 
small to be legible). 

In this lesson you will learn how to work with layouts. 

Step 1 - Creating a new layout

To create a new layout

1 In Presentation mode, click the Layouts tab.

2 Right-click in the Layouts shortcut area, and then choose New Layout.
3 Type a name, and then click OK.

Note: By default, empty layouts are set up to use 8.5” x 11” sheets of 
paper. 
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To modify the paper size

1 Right-click in the layout area and choose View Options. 

2 The View Options window will open.

3 From the Paper Size drop-down list, select the desired paper size. 
4 Click OK to save your changes and exit.

The Grid and gridlines 
When enabled, the Grid option displays gridlines over the paper. These 
gridlines are constant and for reference only; they assist with the 
alignment of items on the page. Gridlines do not appear in the printed 
output.

Snapping
Snapping is available when inserting items on the layout. The snapping 
interval is defined in the View Options, and is completely independent of the 
gridline spacing. 

Paper Size
When choosing a paper size for your layout, select the physical paper size 
(dimensions) that you will be printing your final plot on. Changing the 
paper size will change the virtual paper representation, i.e. the white 
rectangle, displayed in the Layout tab which represents your lighting plot.
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Adjusting Zoom Level and Panning the Layout
Zooming on the layout can be done by pressing the PAGE UP and PAGE 
DOWN keys on the keyboard, or by scrolling the MOUSE WHEEL. Pan the 
layout by holding down the MOUSE WHEEL.

Step 2 - Inserting and manipulating objects into the layout

To insert objects on the layout

1 To insert and object, select the appropriate icon from the Pres Insert 
toolbar.

Create Layout Template

Insert Layout Template

Delete Layout Template

New Plot Item

Key 

Legend 

Worksheet Item

Report Item

CAD Item

Image

Line

Rectangle

Round Rectangle

Ellipse

Text

2 Click and drag a window (placeholder) on the layout where you want 
the item to appear.

3 Repeat this procedure for all desired items. 

To resize an object in the layout 

1 In your layout, click the object you want to resize to select it. 

Result: The object’s grip handles are displayed. 

2 To resize the item on the paper, click and hold on the object’s handle, 
then drag to alter the size.
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Locking items in layouts
You can “lock” items in your layouts to avoid accidentally moving or 
deleting them once you are satisfied with their placement. Once an item is 
locked, you can still select it (and access its Properties), but you can’t move 
or delete it.

To lock/unlock an object in a layout

1 In your layout, click the object that you want to lock.

2 To lock the object, on the Layout Pres Edit toolbar, click the Lock 
button.

 The Lock button.

Note: Alternately, you can click CTRL + L to lock the selected item.
Result: The grips of the item turn red instead of black and you cannot 
move or delete the object.

3 To unlock the object, click on the Lock button.
Note: Alternately, you can click CTRL + L to unlock the selected object.

Alignment Tools
Use the Alignment Tools found on the Layout Pres Align toolbar to easily 
line up objects you’ve inserted onto a layout. 

To align objects 

1 On the Layout Pres Align toolbar, set up a point of reference which 
selected objects will align to. Select one of the following:

Align to Extents - All selected objects (regardless of selection 
order) will align to the left-most, right-most, bottom-most, 
etc. point of the left-most, right-most, bottom-most, etc. 
object, respectively.

Align to First Selected - Objects selected after the first object 
was selected will align to that first object.

Align to Last Selected - Objects selected before the last object 
was selected will align to that last object.

2 In the layout, select your first object, and then a second object.
3 Click on an alignment option to align the two selected objects.

Step 3 - Modifying CAD items

A CAD item contains a section of your wireframe drawing. You can think of it 
as a 'window' into the CAD mode drawing, on your plot. 
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To modify CAD items
In this example you will modify the scale of a CAD item. When a new CAD 
item is added to a layout, its View type is set to Plan view and its scale is 
fixed to 1/16” = 1’0”. These defaults, and others, may be modified via its 
Content Properties window, as follows:

1 Select the CAD item, right-click, and then choose Content Properties. 

2 The Content Properties window will open.
3 Click the CAD Printing tab.

4 Click the Fixed option button.
5 From the drop-down list, select Custom.
6 Type the scaling to be used when printing the drawing, for example, 

fixed at 1/8”=1’. 
7 Select any other desired items, and then click OK.
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Step 4 - Adding legends and keys

The Legend and Key Wizards guide you through the process of adding a 
legend or key to your layout. 

 Legends: You may want to add a legend to your layout to provide a 
definition of the symbols used in the layout. The legend you create can 
include the symbol name, wattage, count, and any other special notes. 

 Keys: You may want to add a key to your layout to provide a definition 
for the fixture notation used in the layout. The key you create can 
include the symbol of one given fixture and identifiers for the various 
attributes notated around the symbol. 

To create a legend

1 Right-click in the Wizards shortcut bar, and then select New Legend.

Result: The Enter new Legend name dialog box is displayed.
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2 Type a name for the legend, and then click OK. 
Result: The legend shortcut is stored in the shortcut bar and the Legend 
Wizard opens. The Legend Symbols Editor appears as displayed below. 
All fixtures in your CAD drawing are listed in the Legend Editor for 
possible inclusion in the Legend. All the options to configure your 
Legend are available from this dialog. 

a. Legend layout
Options found here affect the layout of your legend.

 Title: The Title field will display the name of the legend. Type a title in 
the Title box if you want a title other than the default name to be 
displayed. 

 Automatic updates: By default, this option is on and will automatically 
update the legend when there are updates in your CAD drawing

 Display Columns: The Display Column button is used to edit what 
columns are displayed in the legend. Clicking the button will bring up 
the Legend Options window. From here choose the columns that you 
want displayed by marking the appropriate columns from the list. 
The Symbol and Name columns are displayed by default. Order the 
display of columns by clicking the Up and Down buttons. 
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 Rename: You can type a name for the selected Legend Column 
header.

 Move Up: Select a row and use this button to move the fixture row up 
in the table. 

 Move Down: Select a row and use this button to move the fixture row 
down in the table. 

 Reset to Default: When a fixture row is selected that has cells that 
have been edited, this button becomes active. By clicking this 
button, the all the editable cells in the row will be reset to their 
default text. 

 Symbol: The Fixture Symbol section displays up to three symbols that 
represent a fixture from different views, Plan, Front, Side, if 
available. Use the checkbox under each symbol if you wish it in the 
Legend. 

Note:  At least one symbol must be displayed for each symbol.  

b. Legend information

Each symbol type that exists in your CAD drawing is displayed for 
possible inclusion in the legend. The counts of each symbol type is 
updated automatically as symbols with the same symbol type are 
added or deleted from the CAD drawing. 

Options found here affect the symbol information that is displayed in 
the legend. 

 Display checkbox: By default all fixtures are displayed in the legend, as 
identified by the check box. Click to deselect this check box if you do 
not want the highlighted fixture in the table to be displayed in the 
Legend.  

 Symbol: This column displays the name of the Symbol from the 
Library which represents the fixture in your CAD drawing and will be 
displayed for this fixture on the Legend. 
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 Name: By default, the name of the fixture will be displayed, as listed 
in the Library Browser. If you wish to edit the displayed fixture name, 
click in the cell and type in your preferred Name for display. 

 Count: By default, the total number of the fixture in the drawing 
appears in the Count column. This value includes only hung fixtures 
in your show file. If you wish to edit this number, click in the cell and 
enter a new count. 

 Spares: By default, this column is blank. If you have spare fixtures 
that you would like to display on your Legend, click in the cell and 
enter a number of Spares. 

 Wattage: By default, the table displays the wattage for the Lamp in 
volts. If you wish to edit this value, click on the cell and enter a new 
Wattage value. 

 Lamp: Displays the lamp of the fixture.    
 Fixture Options: Displays any options that are available on the fixture. 

To edit this cell, click on it and add or remove any of the text. 
 Notes: Type in any additional notes that should be displayed for this 

fixture in the Legend. 
 Color Source: By default, the Color Source will be set to Plot Color, 

which means the Legend will automatically display the symbol using 
the Layer Color or Object Color of the fixture, if the color is the same 
for all instances of the fixture in your drawing. If the color is not the 
same, the Plot Color will automatically be set to Black. Alternatively, 
you switch this column to Custom Color, and then use the column 
beside it using the colorbox to select a custom color for the symbol. 

 Color: Click the Colorbox to open a color picker. Select the new color 
that you want to apply to the symbol, and then click OK 

 Rotate: By default the checkbox is unchecked to display the fixture 
symbol in its default orientation. To rotate the symbol, click on the 
checkbox and select it.

 Mode: Displays the fixture’s mode setting.
 # Channels: Displays the total number of DMX channels required by 

the fixture.

c. Legend display options

How a legend appears in a report can be customized to meet your 
needs. 

Options found here affect how a legend appears in the report.

 Display Legend Title: Enable this option to display a title for your 
legend.

 Display column headings: Enable this option to display the headings of 
columns in the legend.

 Display grid: Enable this option to show a grid separating symbols in 
the legend.
Quick Start Guide 89



Lesson 9 - Creating and modifying layouts Release 2024
L

esson 9
 Max column width: The number sets the width of the columns. The 
width must be set in order to set Word Wrap option. (Note: The 
minimum width for a column is 30).

 Word wrap: Enable this option to wrap text that exceeds the max 
column width.

 Font: Use the drop-down menu to select a support font style. 
 Font Size: Set the font size for all text in the legend layout. 

To create key items

1 Right-click in the Wizards shortcut bar, and then select New Key.
Result: The Enter new Key name dialog box is displayed.

2 Type a name for the key, and then click OK. 
Result: The key shortcut is stored in the shortcut bar and the Key 
Wizard opens. 
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Step 1 - Key Symbol Selection

Options in Step 1 allow you to choose the symbol that will represent the 
fixture or accessory in the key. 

 List of symbols: Select the symbols you want to use. You can choose up 
to one fixture symbol and one accessories symbol. The symbols 
available in this list are the default WYSIWYG symbols for each fixture 
or accessory type. When you selecting a symbol, it appears in the 
preview window to the right. 

 Title: Select the Display Title check box if you want the name of the 
symbol to be displayed in the key. Type a title in the Title box if you 
want a title other than the default name to be displayed.

 Change Symbol: Enables you to choose a different symbol from the more 
extensive symbols library which includes the USITT standards, among 
others. Follow the steps in “Changing Symbols” to perform the 
modifications.
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 Delete Symbol: Click this button to remove the selected symbol from the 
preview window. 

Changing symbols

From the list of items in the window to the right of the preview window, 
select the symbol. To change the symbol, select the symbol name 
under the preview window and click the Change Symbol button. The 
Symbol Select window appears:

From the list on the left side, choose the new symbol. When you are 
finished making your choice, click Select. 
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Step 2 - Symbol Layout

 

For each attribute there are two entries in the list box. One is for the 
attribute itself; the other is to label the attribute. The label is 
distinguishable by the qualifier “Key” (for example, the attribute Focus 
and the label Key - Focus). An extension line is drawn between the label 
and the attribute. For each attribute and its label you must decide 
whether you want to display it in the key. If yes, you can further specify 
how it will be displayed using the various formatting options (including 
text size and color, shape size and color, and justification).

You can also edit all the text, choose to give examples of attribute 
values, and provide custom definitions for the labels.

Options in Step 2 allow you to choose the attributes and notation to be 
displayed around the chosen symbols. 

Note: To make the controls active, you may have to click to clear the 
Use Defaults check box. 
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 Visible: Select this check box if you want the attribute or label to be 
displayed around the symbol in your key.

 Use Body Color: Select this check box if you want the attribute or label 
to use the same font color as the symbol. To set a specific color for 
the attribute or label, leave the box unchecked and click the color 
box to choose a custom color.

 Line weight: Adjust this value to increase or decrease the density of 
the label or attribute font.

 Text: Type the text that you want displayed for the attribute or label. 
 Italics: Select this check box to italicize the attribute or label font. 

Note there are no options to change the font.
 Horizontal and vertical justification: Choose the justification for the text. 

This is in relation to the insertion point or shape.
 Height: Increase or decrease to modify the font size.
 Angle: Specifies the attribute or label alignment in relation to the 

fixture symbol.
 Shape: Associate a shape with the label or attribute, if desired. You 

can choose from: none, circle, square, octagon, or diamond.
 Size: Increase or decrease the size of the shape as desired.

3 Set the position of the attribute or label by clicking and dragging on the 
label or attribute in the preview window. You can also select an 
attribute by clicking on it in the preview window. 

4 The key as it will be drawn on the layout is displayed in the preview 
window. Once all the attributes are set as desired, click Finish.
Result: The Wizard shortcut is stored in the shortcut bar with the 
name you specified in the Title box. 

To place the legend or key

1 On the Insert toolbar, either the Legend or Key icon.

2 Click and drag a window placeholder on the layout where you want the 
legend or key to appear.
Result: A message box prompts you to select the legend or key from 
the list. 

3 Highlight the legend or key, and then click Select.
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Lesson 10 - Patching

Introduction

In WYSIWYG, you can create two types of patch universes:

 DMX - When you create this type of patch universe, you can patch 
fixtures or movement axes to it by assigning them a DMX address. The 
Patch tab in Data mode is a visual representation of your DMX patch 
setup and is also used to monitor DMX activity while connected to a 
console.

 Motion Control - When you create this type of patch universe, you can 
patch movement axes to it, and then use a motion control system (or 
WYSIWYG’s Motion Control Console) to control the movement of any 
objects that are attached to the axis.

In this lesson you will learn how to patch fixtures and read a resulting patch 
universe.

Working in the Patch Layout tab
You can view one patch universe at a time. As you add new patch universes 
in either a Spreadsheet view or a CAD drawing (using Quick Tools), their 
shortcuts are created automatically and listed in the Patch tab. You can also 
create new patch universes directly from the Patch tab's Shortcut bar.

Step 1 - Creating a new patch universe in the Patch tab

To create a new patch universe

1 In Data mode, click the Patch tab.

2 Click the Patch shortcut bar. 
Result: The Patch shortcuts are displayed.

3 Right-click in the shortcut bar, and then select New Patch. 
4 Type the name of the patch universe. Patch universes can be named 

anything. For example, "A", "B", "C", or "Dimmers", "Movers", 
"Scrollers", and so on.

5 Select the type of patch universe based on the type of console or 
system that you are using, either a DMX console, or a motion control 
system.

6 Click OK.
Result: The patch universe is created and its shortcut appears in the 
Patch shortcut bar.
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Step 2 - Patching fixtures and movement axes

To patch fixtures and movement axes in the patch layout 
screen

1 In the CAD drawing in the top pane, click to select the desired fixture or 
movement axis or frame.

2 Click and drag the fixture/axis/frame into the DMX or motion control 
patch universe in the bottom pane.

3 Repeat for all fixtures/movement axes as desired. 

Note: While this method of patching is slow, it is the only method that 
provides instant visual feedback for what was patched. For faster patching 
use Quick Tools, or direct input into DATA > Spreadsheets, as described in 
earlier lessons.

Step 3 - Repatching/unpatching a fixture

To repatch a fixture

Select the desired fixture by clicking its first DMX attribute directly in the patch universe, 
and then drag it to a new address.

To unpatch a fixture

1 Select the desired fixture.

2 In the patch pane, right-click and select Unpatch.
Result: The fixture will be removed from the patch pane and become 
unpatched.

Step 4 - Reading the patch

Reading the DMX patch

The name of the patch universe is displayed in the title bar. 

Each box in the patch universe represents one DMX channel. The channel is 
identified by the number in the top-left corner. Fixtures are represented by 
colored bumps that span the number of DMX channels they require. The 
color of the bump is the Wireframe color assigned to that fixture (typically 
the fixture's Layer color).

If you are connected to a console and are receiving a DMX signal, the 
incoming DMX values are displayed in the top right corner of each box. 

The fixture parameter controlled by each channel is identified in the center 
of the box, e.g. Intensity. 
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The spot number and fixture type span the bottom of the box. 

Universe name

DMX address

Fixture parameter

Spot number and
fixture type

To patch a motion axis to a DMX console device

In WYSIWYG, you can patch a motion axis to which one or more objects has 
been attached, and then use a console device or a motion control system to 
control the progress of the objects along the axis. 

You have the choice of patching the axis to either a DMX patch universe or 
a motion control universe, based on the type of console or system you will 
be using to move the objects. For details on patching the axis to a motion 
control universe, see “To patch a motion axis to a motion control 
system” in the WYSIWYG Reference Guide. 

Reading the patch for moving scenery
If you have patched a motion axis, the patch appears as shown below:

Axis ID

Axis name

Position of the 
object on the axis
as reported by
the motion control
system

 For linear motion axes, the position of the object is reported in either 
metric or imperial units (for example, 16m). 

 For rotational axes, the value is shown in degrees (for example, 42°).
 If the axis is unrecognized by the motion controller, then the object 

position is shown as a question mark (?).

Note: If the axis type is mismatched between that which you have drawn 
and the type that you choose in the Motion Control Console (for example, if 
the actual axis is linear, but you choose rotational in the Motion Control 
Console), then the cell in patch view turns to red.

For more information on how to patch objects in WYSIWYG, please refer to 
the WYSIWYG Reference Guide.
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Lesson 11 - Inserting and connecting to a 
console

Introduction

WYSIWYG enables you to visualize and pre-cue your lighting show in real 
time. To use Live mode, you must be connected to a DMX console, 
compatible off-line editor, or a motion control system.

WYSIWYG enables you to visualize and pre-cue your show in real time, by 
connecting to a lighting console, its "on PC" counterpart (running on the 
same computer as WYSIWYG or another computer) or to a motion control 
system. All this is accomplished in Live mode.

Note: Ensure that your hardware and/or software is properly set up.

In this lesson you will learn how to insert a console and connect that 
console in Live mode. 

Step 1 - Inserting a console

To insert a console

1 From the Managers menu, choose Device Manager.

Result: The Device Manager window will open.
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2 In the Device Manager window, click New.
Result: The Library Selection window will open.

3 Expand the Manufacturer section, and then choose the desired console 
(for example, Express 24/48). 

4 Click Insert. 
Result: The console will be inserted into the Device Manager window.

Note: If connecting to a console via a "DMX over Ethernet" protocol 
such as Art-Net or sACN, the required protocol must be inserted, not 
the console itself. For more information about connecting to these 
protocols, see “Connecting to an sACN Device” and “Connecting to 
an sACN Device” in the WYSIWYG Reference Guide.
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Step 2 - Connecting to a console

To bind the console output to the patch universe

1 In the Device Manager window, highlight the console, and then click 
Properties. 

2 The Properties window of the console will open.

3 Refer to the connectivity guide for the console you wish to connect to 
for information on what Protocol and/or Address to select/enter in the 
Protocol and Address fields.

4 The Name field can be filled with anything at all. For example, "Audience 
Lighting (Console)", "B-Stage (Console)", etc.

5 A list of the output ports from the console appears in the Ports list. You 
must bind these outputs to WYSIWYG patch universes. Click the 
appropriate port to highlight it.
Note: Motion control systems have a single port named “Motion.”

6 Click the Universe column to display a drop-down list containing all the 
patch universes created in this file (Step 1 of Lesson 10). Select from 
the list the patch universe to bind/connect to the selected port.
Note: If you are working with a motion control system, then you can 
bind only to motion universes; if you are working with a DMX console 
then you can bind only to DMX universes.
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7 Repeat the above steps to bind all ports to their appropriate patch 
universes. 

8 Click Close to exit the Properties box.
9 Click Connect. 

Result: The status of the console changes to “connected.”

10 Click Close to exit the Device Manager.
Note: Once the console is running and connected to WYSIWYG , 
operate the console as you would normally. Run up channels and 
record cues using the console. Remember that WYSIWYG does not 
store or save cues—this is done in your console’s memory. 

For more information on how to patch objects in WYSIWYG, please refer to 
the WYSIWYG Reference Guide.

To patch multiple ports simultaneously
Note: When assigning multiple ports to universes, the selected ports 
will be assigned to universes in sequential order. The universe 
sequence is based on availability, then alphabetical order.

1 From the Managers menu, choose Device Manager. 

Result: The Device Manager dialog box is displayed.

2 Select the console. 
3 Click Properties.
4 Select the ports for which you want to patch.
5 Click Assign.

Result: The Quick Patch Assignment window will open.

a. To have all universes available for patching, even ones that were 
previously assigned, mark the checkbox by Show Assigned universes 
(Indicated by *). Otherwise, only unassigned universe will be 
available to patch.
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6 In the Quick Patch Assignment window, from the Available Universes drop-
down menu, select the universe that will be assigned to the first 
selected port.
Result: A summary of the assignments will be displayed in the window. 

7 Click OK.
Result: The ports will be patched to universes. The first port selected 
will be assigned to the first universe selected. The next sequential port 
will be patched to the next sequential universe. This continues until all 
the selected ports are assigned, or there are no more available 
universes to assign. 

8 Click Close to exit the Properties box.
9 Click Connect. 

Result: The status of the console changes to “connected.”

10 Click Close to exit the Device Manager.

Device Manager toolbar

The Device Manager toolbar simplifies your regular device connect/disconnect 
operations. You can use the drop-down on this toolbar to select a device 
(Consoles, Devices, Networks), and then click the connect icon or the 
disconnect icon.

The “All Devices” option in the drop-down enables you to easily connect/
disconnect all devices with one click without opening the Device Manager.

For more information on connecting to a console or device, or to connect to 
a "DMX over Ethernet" network, please refer to the appropriate sections in 
the WYSIWYG Reference Guide.
Quick Start Guide 103



Lesson 11 - Inserting and connecting to a console Release 2024
L

esson 11
104



March 2024  Lesson 12 - Using streaming video
L

es
so

n 
12
Lesson 12 - Using streaming video

Introduction

You can bring a live or pre-recorded video into WYSIWYG and play it back 
while you set Looks in Design mode and while you precue in Live mode. 

The Video Manager enables you to create video sources (and subsources) 
which you can then assign to screens, 3D primitives (surfaces, risers, 
spheres, cylinders, and cones), LED Walls, and to projectors that you have 
inserted in your file from the Video Projection section of the Fixtures library.

Live video comes from an external source, such as a video capture device 
or a CITP/MSEX video stream from a media server. Pre-recorded video 
comes from video files, either in AVI or MPG format.

Notes: If you cannot view these file types, you may not have the proper 
CODEC installed on your PC. Install the appropriate CODEC, and then try 
viewing the file again. 

Video sources can be split it up into subsources, which enables you to apply 
portions of the video to multiple screens, 3D primitives, LED Walls, or 
projectors. For details on splitting video, see the WYSIWYG Reference 
Guide.

Once you configure the video source and attach it to an object, you use the 
Video Designer Tool in Design mode to play the video.

In this lesson you will learn how to

 configure a new video source with the Video Manager
 draw the screen on which the video will play and assign the video 

source to it
 use the Video design tool to play the video
 use a console to play the video
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Step 1 - Configuring a new video source

To configure a new video source for streaming video
In this step you create a new video source for streaming video with the 
Video Manager. You can select a video file or you can capture a live video 
stream from an external source, such as a video capture device that is 
attached to your computer (provided that you have WYSIWYG Perform). 

For video files, you must select one of the following video file formats for 
playback:

 Motion Picture Experts Group (MPEG)
 Audio-Video Interleaved (AVI) 

Note: If you cannot view these file types, you may not have the proper 
decoder installed on your PC. Install the appropriate decoder, and then try 
viewing the file again. For help on installing the decoder, consult the 
developer of the video file type.

For live video streams, your capture device must be using WDM drivers.

Note: You can only incorporate live video if you have WYSIWYG Perform; 
you cannot use a live video from a video capture device or video streaming 
via CITP/MSEX if you have WYSIWYG Design.

1 In LIVE mode, click Managers > Video Manager. 

2 Click the New icon in the upper-left corner.
Result: The Video Source window opens.
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3 In the Name box, type a descriptive name for the video.
4 In the Input section, select and configure the new video source.

 To play a video from a file, click the Video File option button, and 
then click Browse to locate the file.

 To capture a live video stream from an external source, such as a 
web cam or a video capture device that is attached to your 
computer, click Video Capture, and then use the drop-down arrow to 
select the appropriate device. (This option is available only if you 
are running WYSIWYG Perform.) WYSIWYG will detect what 
standard resolutions the capture device can support, and display 
them in the Resolution drop-down box; click this drop-down to 
choose your preferred resolution.

 If you select a video capture option, configure the Input and 
Resolution values for the device:

 Input: Choose between various inputs found on video capture 
devices (e.g., HDMI, DVI, S-Video, and so on). 

 Resolution: Select the resolution of the incoming video, provided 
that multiple resolutions are available from the selected input.

Note: The video capture device must already be configured on your 
computer and must be using WDM drivers. Also, it must not be 
currently in use by another application.
 To stream video from a media server on your network, first ensure 

that the CITP Interface option is enabled on the Application Options > 
Additional Interfaces tab, as detailed in the WYSIWYG Reference 
Guide. (This option is only available if you are running WYSIWYG 
Perform.) Then, click CITP Video Stream and click Browse to select one 
of the media servers from the network. If you have just enabled this 
option, you will need to restart WYSIWYG before the CITP interface 
is turned on.

Note: In order for the media servers to be detected, they must be in 
the same logical network as your WYSIWYG computer and any and all 
firewalls (on your WYSIWYG computer, on the media servers, if 
applicable, and so on) must be disabled. For more information about 
how to correctly assign IP addresses for this purpose, consult your 
Media Server and/or Microsoft Windows documentation.
 If your media server is capable of outputting several video streams 

at once, you may select which output/stream to connect to by 
entering the number of the output/stream in the Video Num box. If 
you leave the default value of 0, WYSIWYG will connect to the first 
output; if you enter the number 1, WYSIWYG connects to the 
second output/stream of the same media server; the number 2 
connects to the third output/stream, and so on.

 Use the Network Device Standard to stream video in real-time from 
an external device within the IP space. NDI® is a standard that 
allows multiple video systems to encode, transmit and receive 
streams of high quality, low latency, frame-accurate video over an 
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IP in real-time. For more information on NDI®, click More Info to see 
the link http://https://www.ndi.tv/ and access basic NDI® tools.

Note: NDI® video streams will be detected when they are in the same 
logical network as your WYSIWYG computer.

5 To control video playback via DMX, click DMX Patch, and then use the 
drop-down arrow to select the appropriate patch universe to control 
the video. In the box to the right of the drop-down list, type the 
starting DMX address. 
Note: A patch universe cannot be created from within the Video 
Manager dialog; if you wish to patch video control to DMX, you must 
create the necessary patch universe(s) before you open the Video 
Manager.

6 To mute the sound of the video, in the Video Manager table, click the 
checkbox in the Mute column. If you do not select this checkbox, the 
video’s sound will play.

7 Click OK. If the video is available, it connects automatically.
8 Click OK to save your changes and close the Video Manager.

Step 2 - Drawing a screen and attaching the video source

To draw a screen and attach the video source

1 In CAD mode, from the Draw menu, click Screen.

2 In the appropriate boxes, type the width and height of the screen (or 
accept the default width of 8 feet and height of 6 feet).

3 To configure the image that will appear on the screen, click the 
appropriate option button:
 To leave the screen blank, click the Blank Screen option button.

 To show a static image on the screen, click the Image File option 
button, and then click Browse to locate the graphic. 

 To attach the video source that you have just configured to the 
screen, click the Video Source option button, and then choose the 
video source from the drop-down box.

4 Click OK.

Step 3 - Using the Video design tool to play the video

After you draw the screen and attach the video source, you use the Video 
Designer Tool in Design or CAD mode to start the playback or stream. You 
can view the video in any of the shaded views, using the controls on the 
Video Designer Tool to pause, fast forward, rewind, or stop the video. 
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To use the Video design tool to play the video

Once you have the video source attached to the screen, you must use the 
Video design tool to control it.

Video 

Stop

source 
name

Rewind 
to 
beginning

Play
Pause

Advance 
to End

Note: If the video control is patched and DMX connected in Live Mode, then 
you will not be able to control the video using any of the Video design tool 
commands in Design mode. Video sources can only be controlled by a 
designer tool when the DMX source is disconnected; therefore, you must 
first disconnect the applicable console device from within Live Mode before 
using any of the Video design tool commands.

1 Click the Design mode button.

2 Click the Shaded tab to view the video screen(s) that you have drawn.
3 Click the Video Design Tool icon to open the Video Design Tool window. 
4 From the drop-down list, select the video source. 
5 Use the controls shown in the graphic above to play, pause, or stop the 

video. You can also use the slider to manually advance or rewind the 
video at your desired speed. 
Note: When you press the Pause button, the frame of the video that is 
playing at the time is held on the video screen; when you press the Stop 
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button, the video stops playing and the screen goes blank and the 
video returns to the beginning. 

Step 4 - Controlling the video with a console device

You can also patch the control of the video source to a console device. This 
means that you can use the console device to control the progress of a live 
video stream or a video file by making the video play, pause, or rewind; 
you cannot use WYSIWYG to change different aspects of the video itself. 

Note: To control the video source with a console device, you must have 
selected DMX Patch in the Video Source window in Step 1, and then chosen 
the patch universe for the video source. Also, your console device must be 
connected.

To control a DMX patched video source with a console

After you have patched the control of a video source in Data mode, you can 
use the applicable console device to control the progress of the video in 
Live mode. 

To control the video source, the DMX patch is allocated three channels, 
each given a different name in the patch window: 

 The first channel is called Intensity.
 The second channel is called Control.
 The third channel is called Position. 

For details on the channel levels, see the Reference Guide. 

1 Click the Live mode button.

2 Click the Shaded tab.
3 Ensure that the console device is connected to the patched video 

source. 
 To play the video from start to finish, perform the following steps:

a. Set the first channel (Intensity) to a value between 128—255 
(above 50%).

b. Set the second channel (Control) to a value between 170—255 
(between 66% and 100%).

 To pause the video, perform the following steps:

a. Set the first channel (Intensity) to a value between 128—255 
(above 50%).

b. Set the second channel (Control) to a value between 170—255 
(between 66% and 100%) and play the video to the spot where you 
want to pause it. Then move the second channel to a value between 
85—169 (between 33% and 66%) to pause the video at this spot.
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 To control the progress of the video manually, perform the following 
steps:

a. Set the first channel (Intensity) to a value between 128—255 
(above 50%).

b. Set the second channel (Control) to a value between 1—84 
(between 1% and 33%).

c. Slide the third channel (Position) up and down to control the 
progress of the video, forward and backward. 

Notes: 

 Before you render your drawing, you can either pause the video at the 
precise image you want to see in the final rendering, or you can let the 
video run while the Render Wizard processes the information in your 
drawing. In this case, the Render Wizard captures the video frame that 
was showing when it processed the screen information. 

 If the video control is patched and DMX connected in Live Mode, then 
you will not be able to control the video using any of the Video Designer 
Tool commands in Design mode. Video sources can only be controlled 
by a designer tool when the DMX source is disconnected; therefore, you 
must first disconnect the applicable console device from Live Mode 
before using any of the Video Designer Tool commands. 
Quick Start Guide 111



Lesson 12 - Using streaming video Release 2024
L

esson 12
112



March 2024  Lesson 13 - Using moving scenery
L

es
so

n 
13
Lesson 13 - Using moving scenery

Introduction

You can view moving scenery in WYSIWYG by creating linear or rotation 
movement axes, attaching objects to them, patching them in Data mode, 
and then using a motion control system (or WYSIWYG’s Motion Control 
Console) to define the object’s position along the axis. You can attach 
objects such as risers, library objects, or custom objects that you have 
drawn. 

Notes: 

 When attaching axes to one another, you cannot create a circular 
linking pattern. For example, you can link Axis A to Axis B, and then 
link Axis B to Axis C, but you cannot then link Axis C back to Axis A 
because this creates a circular link.

 You cannot attach fixtures to movement axes; however, you can attach 
pipes that hold fixtures to axes. 

 Currently, you cannot attach focus positions or groups containing focus 
positions to movement axes. 

Step 1 - Drawing the movement axis

To draw a linear movement axis

1 In CAD mode, Wireframe view, select the view in which you want to 
draw the axis (plan, front, back, side, or isometric)

2 Click Draw > Axis > Linear Axis.
3 In the window that appears, type a name for the axis, and then click 

OK.
4 In your drawing, click in the position where you want to start the axis, 

and then move your cursor to the next point of the axis and click. To 
create an axis with multiple segments, continue clicking at each point 
(vertex) of the axis. 

5 When you are finished creating the axis, right-click and choose Finish 
Axis.

To draw a rotation movement axis

Note: Unlike linear axes, rotation axes cannot have multiple vertices. 
Instead, when you draw one of these axes, the object rotates around the 
center point.
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1 In CAD mode Wireframe view, select the view in which you want to 
draw the axis (plan, front, back, side, or isometric).

2 Click Draw > Axis > Rotation Axis.
3 In the window that appears, type a name for the axis, and then click 

OK.
4 In your drawing, click in the position where you want the axis to 

appear.
Note: The circle that appears when you draw a rotation axis is only a 
visual cue to show you the direction in which the object rotates—it does 
not affect the size of path on which the object rotates. The circle is 
given a default size, but you can change it to suit your needs.

Step 2 - Attaching a movement axis to a patch universe

To attach a movement axis to a DMX patch universe
To move the object with a DMX control, you first have to attach the 
movement axis to a named DMX patch universe that you have created in 
Data mode.

Note: For information on creating a patch universe, see “Step 1 - Creating 
a new patch universe in the Patch tab” on page 95.

1 Click to select the axis that you want to attach to the patch universe.

2 Right-click and select Properties.
3 Click the Axis tab.
4 Click the DMX Patch option button.
5 From the Universe drop-down box, select the DMX patch universe to 

which you want to attach the axis.
6 In the Address box, type the starting DMX address.
7 Click OK.

To attach a movement axis to a motion patch universe
To move the object with a motion control system, you first have to attach 
the movement axis to a named motion control patch universe that you 
have created in Data mode. 

Note: For information on creating a patch universe, see “Step 1 - Creating 
a new patch universe in the Patch tab” on page 95.

1 Click to select the axis that you want to attach to the patch universe.

2 Right-click and select Properties.
3 Click the Axis tab.
4 Click the Motion Patch option button.
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5 From the Universe drop-down box, select the motion control patch 
universe to which you want to attach the axis.

6 From the ID drop-down list, select the ID on the motion control system 
with which you want to associate this axis. 
Note: The motion control system must be connected to your computer 
for the ID to appear in this drop-down list. If the system is not currently 
connected, you can also type the ID directly into this drop-down list 
box.

7 Click OK.

Step 3 - Attaching objects to the movement axis

To attach an object to a movement axis

Notes: 

 You can attach one or more objects to each axis; however, each 
object can be attached to only one axis at a time. 

 When you attach an object to a linear axis, the distance from the 
axis to the object does not affect the object’s movement; the object 
will always follow the path of the axis regardless of where you have 
placed the axis or object. 

 When placing the object to be rotated in your drawing, note that its 
position relative to the rotational axis is important. The distance 
from the central point of the axis to the object represents the size of 
the circle in which it will rotate. To have the object rotate in a very 
tight circle (for example, a dancer doing a pirouette, or a spinning 
object), place the object directly on the center point of the axis.

1 Place the object that you want to attach to the axis at the appropriate 
position in your drawing, either by adding a new object, or moving an 
existing object to this location.

2 Select the object, right-click, and then choose Properties.
3 On the General tab, from the Attach to Axis/Frame drop-down box, select 

the axis to which you want to attach this object.
4 Click OK.

Step 4 - Viewing moving scenery

You have two choices when viewing moving scenery:

 You can use the Moving Scenery Designer Tool and the Cross-Fade feature 
in Design mode to fade between Looks containing moving scenery.

 You can use a DMX console or a motion control system in Live mode to 
control the movement of objects attached to patched movement axes. 
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To view moving scenery in Design mode

1 In Design mode, in the shortcuts bar, click Looks.
2 In the Looks shortcut area, right-click, and then select New Look.
3 In the Name box, type the name of the new Look.
4 In the Fade time box, type the fade time in seconds for this Look. 
5 Click OK.
6 Scroll to the bottom of the Looks shortcuts list.
7 Click on the shortcut for your new Look.
8 Click the Moving Scenery Designer Tool button

 The Moving Scenery Designer Tool button.

.

9 From the drop-down list in the Scenery window, select the appropriate 
movement axis. 

10 Click the slider to advance the object to the position where you want it 
to start on the selected axis. 
Note: In the Start box, you can also type the object’s position as a 
percentage of its full range of movement. For example, to show the 
object at the exact half-way mark on the movement axis, type 50. 

11 To create the next Look, in the Looks shortcut area, right-click, and 
then select New Look.

12 In the Name box, type the name of the new Look.
13 In the Fade time box, type the fade time in seconds for this Look. 
14 Click OK.
15 Scroll to the bottom of the Looks shortcuts list.
16 Click on the shortcut for your new Look.
17 From the drop-down list in the Scenery window, select the appropriate 

movement axis. 
18 Click the slider to advance the object to the position where you want it 

to start on the selected axis. 
19 Ensure that the Fade Looks button is enabled so the Look fades instead 

of jumping directly to the next Look.

 The Fade Looks button.

 

Tip: If the button is not enabled, then you can “jump” from one Look to 
the next by clicking the Look shortcuts in the shortcut bar. Even if the 
button is enabled, you can always jump to the next Look by right-
clicking the Look shortcut, and selecting Jump to.

20 To watch the “fade” from the first Look to the second Look, click the 
shortcut for the second Look. The object moves from the starting point 
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of the first Look to the starting point of the second Look over the period 
of time that you specified as the fade time for the second Look. 
Tips: 
 For a more realistic view of the fading between Looks, click the 

Shaded tab.

 To jump directly to a specific Look, right-click the Look, and then 
select Jump to.

 For details on controlling the object’s movement with a console 
device, such as the Mini Console, see “To control a DMX patched 
movement axis with a console in Live mode” below or “To control a 
motion-control patched movement axis with a motion control 
system in Live mode” on page 118.

To control a DMX patched movement axis with a console in 
Live mode
After you have patched a movement axis in Data mode, you can use the 
applicable console device in Live mode to control the movement of any 
objects that are attached to the axis. 

To control the object, the DMX patch is allocated two channels with the 
following controls:

 First channel (Move): The first channel is for coarse movement and 
can be used to advance the object quickly to any position along the 
entire path, from start to finish. 

 Second channel (Move Fine): The second channel is used for further 
refining the object’s position that you set with the first channel. Adjust 
the slider on the second channel to move the object very slightly either 
forward or back from its current position. The movement achieved with 
this channel is so fine, that it is best viewed on linear axes that are 
quite long. Note that for rotation axes, the movement is so slight, that 
you may not be able to see it.

1 Ensure that the console device is connected to the patched movement 
axis. For details on connecting a console, see “Step 2 - Connecting to a 
console” on page 101.

2 To move the object quickly along the movement axis, adjust the slider 
on the first channel, stopping at the position where you want to leave 
the object.

3 To move the object in fine increments either forward or back from its 
current position, adjust the slider on the second channel.
Tip: To view fine movement, the object must be attached to a very long 
linear axis, or be set to rotate in a very wide arc. It is also a good idea 
to zoom in quite close to the object before moving it.
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To control a motion-control patched movement axis with a 
motion control system in Live mode
After you have patched a movement axis in Data mode, you can use the 
applicable motion control system in Live mode to control the movement of 
any objects that are attached to the axis.

Based on the type of system that you are using, you can control the object 
in different ways. The following procedure outlines how to control the 
object(s) with WYSIWYG’s Motion Control Console.

1 Launch the Motion Control Console.

2 Ensure that the Motion Control Console (or the motion control system if 
you are using one) is connected to the patched movement axis. You 
connect the Motion Control Console (and motion control systems) in much 
the same way as you connect consoles. For details, see “Step 2 - 
Connecting to a console” on page 101.

3 To change the settings of a patched movement axis, highlight the axis 
in the left pane, and then choose from the following settings:
 ID box: To change the ID of the movement axis, type the new 

motion control ID. 

 Travel box: Type the distance (in meters for linear axes, in 
degrees for rotational axes) that you want the object to travel along 
or around the axis. This can be the full length/angle of the axis, or 
only a portion of it if you do not want the object to travel along/
around the full path. For linear axes, if you type a value that is 
longer than the actual axis, the object stops at the end of the 
physical axis.

 Type: If you change the axis type so that it does not match the axis 
that you have drawn (for example, if the actual axis is linear, but 
you choose rotational here), the cell in patch view turns to red. 

 In the Mode area, select the type of movement for the object:

 Static: Select this option if you want to specify the precise 
location of a static object on the movement axis. You can then 
use the position slider at the bottom of the window to adjust the 
position and control the movement of the object manually.

 Bounce: Select this option if you want the object to move 
forward and backward in a continuous loop along the movement 
axis.

 Forward: Select this option if you want the object to move 
forward along the axis from start to finish, and then start over 
again at the beginning in a continuous forward loop.

 Backward: Select this option if you want the object to move 
backwards along the axis from finish to start, and then begin 
over again in a continuous backwards loop.

 Duration box: If you have chosen any moving Mode value (that is, 
any value except Static), you can specify the length of time (in 
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seconds) over which you want the full range of motion to take place. 
The larger the number you type in this box, the slower the object 
moves.

 Position slider: For all moving modes (bounce, forward, 
backward), the slider indicates the position of the object when the 
console is sending data to WYSIWYG. For the static mode, while the 
console is started, drag the slider to to adjust the position of the 
object on its axis. The position value changes in the box in the left 
pane.

 Position box: While the console is sending data to WYSIWYG, for 
all moving modes, this box shows the progress of the object’s 
movement along its axis; for the axes in the static mode, you can 
type the precise location of the object on the axis.

4 Click Update Axis to view your new settings.
5 Click Save to save the changes.

Note:  If you make any changes to the axis settings and save the 
changes, you can revert to the previous settings by clicking Load.
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Lesson 14 - Using the Image Manager

Introduction

You can store images as sources in WYSIWYG using the Image Manager. By 
assigning textures to saved sources instead of to specific images, you can 
change or modify the texture of multiple objects at the same time using the 
Image Wizard.

The Image Manager also enables you to perform minor image modifications, 
such as flip horizontal or flip vertical to images without permanently 
changing the source file. This feature is useful in situations where the 
texture is flipped as a result of incorrect surface winding. For details, see 
the WYSIWYG Reference Guide.

You can use the Image Manager to create subsources of an image (i.e., divide 
the image up), which can then be applied to objects such as surfaces, 
screens, LED walls.

Step 1 - Creating an image source in the Image Manager

To access the Image Manager

1 In CAD mode, select Managers > Image Manager.

Result: The Image Manager window appears.
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To create a new image source in the image manager

1 In the Image Manager, click New.

2 Browse to locate the image on your computer, and then click OK.
Result: The image is added as a source. 

Notes: 

 Source Name: The image’s file name.
 Source Path: The path to the physical file. Click the File Open button to 

select a new file.

 The File Open button.

 Flip Horizontal: Click this option to flip the image source horizontally. For 
details, see To flip an image source below. Note that you cannot flip 
image subsources.

 Flip Vertical: Click this option to flip the image source vertically. For 
details, see To flip an image source below. Note that you cannot flip 
image subsources.

 Dimensions: The file’s dimensions in pixels.
 In Use: Informs you of whether the image source is in use. If the image 

source is currently in use, it cannot be deleted from the Image Manager.
 Display Settings

 Show image at: Select the zoom level for the image. You can choose 
to "fit" the image in the display window, or show it at a percentage of 
its actual size: 100% or 200%

 Display Borders: Select this option to show the subsource borders in 
the display.
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 Display Selected Only: When you have selected a subsource in the 
table, click this check box to only show the subsource in the display 
area; if you do not select this checkbox when a subsource is selected, 
the entire source is shown (with the subsource borders highlighted in 
the display if you selected Display Borders). 

Step 2 - Flipping and exporting image sources

To flip an image source
In situations where a surface was drawn in a clockwise direction, the 
texture may appear to be “flipped” either horizontally or vertically. To avoid 
this problem, flip the image source using the Flip Horizontal or Flip Vertical 
checkboxes, as shown below. Note that you cannot flip image subsources; 
only the actual image source can be flipped.

1 Open the Image Manager.
2 In the table to the left, select the image source that you want to flip.
3 Based on the direction in which you want to flip the image, select either 

Flip Horizontal or Flip Vertical.
Result: The image is flipped, as shown in the following sample graphic, 
which was flipped vertically.

To export an image source

After flipping the image, you may want to save your changes to a new 
image file as follows:
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1 Open the Image Manager.
2 In the table to the left, select the image source that you want to 

export.
3 Click the Save icon in the top left of the window.
4 Type a name and select a file type for the new image, or accept the 

default file type of PNG.
Note: When exporting an image source the default file type is PNG, but 
you can choose a different file type, if desired; when exporting a 
subsource, you cannot choose the file type. The subsource is exported 
to the same file type as its source. 

5 Click OK.

Step 3 - Correcting missing images

If you have turned off the option Save external textures within the document in 
Application Options > File Options, when you move image files from their 
original location, they may not load from within WYSIWYG. When this 
happens, the image source will be highlighted in red, as shown in the 
following graphic:

To address this issue, select the image source highlighted in red, click the 
folder icon beside the Path box, and browse to select a new image. When 
you are finished, click OK.
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Step 4 - Creating image subsources

Just as with videos, you can create one subsource or multiple subsources 
from an image using the following procedures. Image subsources are useful 
in scenarios where you need to apply part of an image to one object and 
another. Normally, to do so you would need to open the image in a photo 
editing software program, make your edits, crop the image, and then 
import two images. However, with the image subsource creation feature, 
you can just import the source file, and create the necessary subsources 
within WYSIWYG. For example, you could use this procedure if you have a 
photo that you want to break into quadrants (2 x 2), and then apply each 
quadrant to a separate surface, screen or LED wall, etc.

To create a single image subsource

1 In the left pane of the Image Manager, click to highlight the image for 
which you want to create a subsource.

2 In the bottom left corner of the window, click Single Subsource - create 
one.
Result: The Create Single Subsource window will open.

3 Type the subsource name.
4 By default, the system uses the start and end coordinates of the 

selected source, but you can change these values as desired. When you 
change these values, the system automatically updates the dimensions. 

5 Click the Border box to specify the color of the border that will appear 
around the subsource when displayed.

6 Click OK.
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To create multiple image subsources

1 In the left pane of the Image Manager, click to highlight the image for 
which you want to create subsources.

2 In the bottom left corner of the window, click Multiple Subsources - create 
many.
Result: The Create Multiple Subsources window will open

3 Type the subsource name. 
4 Define the subsource matrix by specifying the number of columns and 

rows. The dimensions of the subsources are displayed for your 
reference.

5 By default, the subsources are created by taking the overall source 
area (height & width) and evenly dividing it by matrix provided. 
However, you can modify the total area by changing the start/end 
coordinates and, therefore, the overall dimensions used to create the 
subsources. To do so, click the check box beside Modify total area for 
subsources, and then type the new coordinates.

Notes: 

 Subsources are always listed below the source from which they were 
created.

 The table in the Image Manager provides a convenient way of displaying 
source/subsource information; all sources and their subsources are 
grouped, and can be expanded/collapsed.

 You can rearrange the columns in the table by clicking the column 
header and dragging it to the new position. 

 You can adjust the width of columns by clicking the column border and 
dragging the column to its new width. 

Step 5 - Changing properties of sources and subsources

Note: If you change the source after the subsources were created, and the 
new source has different dimensions that do not match the subsources 
dimensions, the affected subsources are highlighted in yellow (and a dialog 
appears to notify you as such).
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When you select a row in the Image Manager table, the properties of the 
image source or subsource are displayed in the Source Properties area of 
the window. You can change various properties of the image source and 
subsources as follows:

 To change the border color of image subsources, in the table, click the 
appropriate border color and then click on the drop-down box that 
appears to select the new color. Click Update.

 To change the name of the image source or subsource, in the table, 
click the appropriate row. Type the new name, and then click Update. 

 If you have already applied an image to multiple objects, and then you 
want to replace the source file with something different, you can make 
the change once in the Image Manager and have it automatically applied 
to all related objects (i.e., you don’t have to individually apply the 
changes to each object's properties). To do so, you change the 
underlying source file to the Image name. 

 You can define a subsource either by its start/end coordinates or by its 
dimensions:
 To resize the subsource, click the appropriate row in the table. 

Change the start/end coordinates as desired, and then click Update. 
Note that if you change the coordinates, the system updates the 
dimensions automatically. 

 To change the dimensions of a subsource, click the appropriate row 
and then type the new dimensions. Note that when you change the 
dimensions, the system will automatically add to the start coordinate 
to determine a new end coordinate. Click Update.

Note: You can use the Quick Video/Image Tool to apply the Image 
Subsources. For details, see the WYSIWYG Reference Guide.
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